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Предговор за прво издање 

Овај практикум је настао као одговор на потребу да се студентима, који слушају 

предмет Географски информациони системи (ГИС), на систематичан начин детаљно 

објасни поступак извођења практичних вежби. За извођење вежбања смо се 

одлучили да користимо програм Quantum GIS (QGIS). Основни разлог за 

коришћење овог програма на вежбама је чињеница да је програм уз широку палету 

функција, слободан за коришћење. Програм је отвореног кода, и заједница која га 

развија га свакодневно дограђује. Поред бројних уграђених функција, постоји 

велики број додатака (Plugins) којима је могуће обавити и специфичније захвате 

над просторним подацима. Захваљујући томе, QGIS пружа могућност и за 

савлађивање основних знања рада са просторним подацима као и за примену у 

многим специфичним ситуацијама. QGIS користи стандардне формате података, 

тако да је могуће исте податке  користити и унутар других програмских пакета. 

Quantum GIS се стално ажурира и унапређује. У време писања овог практикума 

актуелна верзија је 2.10.1. Могуће је да ће поједини изгледи прозора у новим 

верзијама програма бити промењени. Међутим, једном прихваћени принципи 

руковања просторним подацима, прикупљања, анализе и презентације истих, се са 

лакоћом могу применити у новим верзијама QGIS-а али и у било ком другом, 

комерцијалном програму намењеном Географским информационим системима. 

Кроз вежбе обрађене у практикуму од студента се очекује да добије основно 

практично знање о облицима просторних података, о начину њиховог уноса у ГИС 

пројекат, о основним операцијама са просторним подацима. Као резултат 

приказаних вежби, студенти треба да савладају основне могућности просторних 

анализа и начин презентације добијених резултата, пре свега путем израде 

картографског приказа. Стечена знања треба да буду подлога за даљу примену ГИС-

а у другим предметима као и у професионалној пракси након завршетка студија. 

Такође сматрамо да ће овај практикум омогућити стицање основних знања из 

ГИС­а и другим студентима, који у свом студијском програму немају овај предмет, и 

иницирати ширу примену ГИС-а и у њиховом даљем школовању и 

професионалном раду. 

 

Аутори. 

  



 

 

Предговор за друго издање 

Након осам година од издавања овог практикума, показало се да Практикум 

представља одличан водич да се направе први кораци у коришћењу географских 

информационих система и велика помоћ да се вежбања предвиђена планом за 

предмет Географски информациони системи успешно савладају и да се студенти 

адекватно припреме за полагања испита. Осим студената на основним академским 

студијама, и студенти на мастер и докторским студијама су прихватили овај 

практикум као помоћ у решавању проблема и задатака који се односе на 

коришћење географских информационих система. 

Показало се као добра одлука аутора да се ослоне на коришћење QGIS-а јер је у 

данашње време QGIS широко прихваћен у великом кругу стручњака који се баве 

географским информационим системима а нарочито у академској заједници. Од 

времена када је припремано прво издање овог Практикума, QGIS се развијао и 

прешло се на верзију 3 овог програма, који се већ значајно разликује и по 

функционалностима које су уграђене у програм, и у корисничком интерфејсу. Тиме 

се наметнула потреба да се иновира садржај овог Практикума и да се припреми 

друго издање. У припреми другог издања, ослонили смо се на QGIS верзију 3.18.1 

из које су коришћени снимци екрана.   

Друго издање је допуњено појединим поглављима, како би се приказале одређене 

функционалности које су уграђене у сам QGIS или се могу уградити као додатак 

(plugin). Ове функционалности се не обрађују на вежбама на основним академским 

студијама, али представљају основу за напредно коришћење QGIS-а за студенте 

виших нивоа студија, али и све друге заинтересоване појединце. 

 

Аутори 

  



 

 

Садржај 

 
1. Инсталација QGIS програма ....................................................................................... 1 

2. Упознавање са QGIS радним окружењем................................................................. 2 

Додавање векторског слоја ..................................................................................... 2 

Подешавање особина слојева ................................................................................. 4 

Уклањање слоја ........................................................................................................ 5 

Снимање пројекта .................................................................................................... 5 

3. Промена размере приказа ......................................................................................... 7 

4. Приказ атрибутне табеле слоја .................................................................................. 9 

Филтрирање атрибутне табеле ............................................................................. 10 

5. Селекција записа у табели коришћењем упита ..................................................... 12 

6. Додаци у графичком приказу .................................................................................. 14 

Приказивање координатне мреже ....................................................................... 14 

Приказ размерника ................................................................................................ 15 

Приказ знака за правац севера ............................................................................. 16 

7. Идентификација објеката ......................................................................................... 17 

8. Исписивања ознака на графичком приказу (Labels) .............................................. 18 

9. Подешавање картографске пројекције ................................................................... 20 

10. Мерење на графичком приказу ............................................................................... 23 

Мерење координата тачака ................................................................................... 23 

Мерење растојања ................................................................................................. 23 

Мерење површине ................................................................................................. 24 

Мерење угла ........................................................................................................... 24 

11. Селекција објеката на графичком приказу ............................................................. 25 

Појединачна селекција .......................................................................................... 25 

Искључивање селекције ........................................................................................ 25 

Појединачна селекција више објеката ................................................................. 26 

Селекција свих објеката унутар правоуганика ..................................................... 26 

Селекција свих објеката унутар полигона ............................................................ 27 

Селекција објеката коришћењем "Freehand" опције. ......................................... 28 



 

 

Селекција објеката унутар круга ........................................................................... 28 

12. Израда слоја тачака из текстуалног фајла .............................................................. 29 

Израда слоја тачака из задатих елипсоидних координата ................................. 30 

Израда слоја тачака из задатих правоуглих координата .................................... 35 

13. Геореференцирање скениране карте ..................................................................... 37 

14. Дигитализација тачака са геореференциране карте ............................................. 42 

15. Дигитализација полилинија са геореференциране карте .................................... 45 

16. Дигитализовање полигона са скениране карте ..................................................... 47 

17. Додавање растерског слоја ...................................................................................... 48 

18. Израда карте падавина (Print Layout) ..................................................................... 51 

19. Рачунске операције са растерским подацима ....................................................... 54 

20. Дигитални модел терена .......................................................................................... 57 

Приказ избором боје према висини ..................................................................... 57 

Рачунање нагиба терена (Slope) ............................................................................ 59 

Рачунање експозиција терена (Aspect) ................................................................. 60 

Приказ осенчености терена (Hillshade) ................................................................. 61 

Генерисање изохипси из ДТМ-а  (Contour) ........................................................... 63 

21. Повезивање података (Join) ..................................................................................... 65 

Просторно повезивање – Spatial Join .................................................................... 65 

Повезивање преко атрибутне табеле – Attribute Join ......................................... 68 

22. Рачунање вредности новог поља у атрибутној табели ......................................... 72 

23. Израда тематске карте ............................................................................................. 75 

Приказ места према броју становника ................................................................. 75 

Приказ мреже путева према категорији пута ...................................................... 79 

Приказ густине становништва ............................................................................... 80 

24. Панел са алатима (Processing Toolbox) .................................................................... 81 

25. Употреба додатних библиотека (Plugin) ................................................................. 83 

26. Додавање новог слоја са удаљених извора у облику XYZ Tiles............................. 85 

27. Додавање новог слоја са Web Map Server-а ........................................................... 88 

28. Интерполација ........................................................................................................... 90 

Метода Тисенових (Thiessen-ових) полигона ....................................................... 91 

Метода инверзно пондерисање удаљености (IDW) ........................................... 91 



 

 

Метода мреже неправилних троуглова (TIN) ...................................................... 94 

29. Одсецање растера (Clip raster) ................................................................................. 97 

30. Одсецање вектора (Clip) ......................................................................................... 100 

31. Формирање тампон зона (Buffer) .......................................................................... 102 

32. Разграничење сливног подручја ............................................................................ 104 

33. Литература ............................................................................................................... 111 

 

 



Географски информациони системи - практикум 
П. Бенка, А. Бездан, Р. Земунац, Н. Сантрач 

1 
 

1. Инсталација QGIS програма 

Инсталација програма QGIS је доступна на web адреси: https://qgis.org 

QGIS је могуће инсталирати као самосталну апликацију (Standalone) или као део 

пакета програма за рад са просторним подацима ОSGeo4W. За извођење вежби 

обрађених у практикуму, биће довољно инсталирати самосталну верзију QGIS-а. 

Након што се сними инсталациона датотека, њеним покретањем се започиње 

инсталација програма. Осим програма, за рад са QGIS-ом су неопходни просторни 

подаци. Потребни подаци за извођење вежби обухваћених овим практикумом се 

могу преузети са дела сајта Пољопривредног факултета, одређеног за предмет 

Географски информациони системи: 

http://polj.uns.ac.rs/~geodezija/predmeti/gis.html. 

За већину вежби обрађених овим практикумом није неопходно да рачунар на коме 

се извршава QGIS буде прикључен на интернет. Међутим, за инсталацију додатака 

(Plugins) или код коришћења online извора просторних података, неопходно је да 

рачунар на коме се извршава QGIS има и прикључак на интернет. 

  

https://qgis.org/
http://polj.uns.ac.rs/~geodezija/predmeti/gis.html
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2. Упознавање са QGIS радним окружењем 

Приликом инсталације QGIS-а, пречица (Shortcut) за покретање програма се 

постави на радну површину (Desktop), а иста се може пронаћи и у Start менију 

Windows оперативног система. QGIS се покреће путем пречице за QGIS Desktop 

. Након покретања добија се графичко радно окружење програма: 

 

Слика 1. Изглед радног графичког окружења QGIS-а 

Радно графичко окружење се састоји од траке са падајућим менијима, више палета 

са алатима (могу се уређивати), главног прозора где се формира графички приказ, 

више прозора који су стално отворени или се отварају зависно од позване функције 

(Прозор са слојевима - Слика 1) и статусне линије где се могу очитати координате, 

размера, коришћени координатни систем итд. 

Изглед радног окружења се може уређивати путем ставке View у падајућем менију, 

а затим кроз ставке садржане у Panels односно Toolbars. 

Додавање векторског слоја 

Рад на неком ГИС пројекту започиње додавањем просторних података. Један скуп 

просторних података ће у QGIS-у бити приказан као један слој (Layer). Поступак 

додавања новог векторског слоја започиње притиском на дугме Add Vector Layer 

(палета са алатима за управљање слојевима) или кроз Data Source Manager 

Координатни систем 

Палете са алатима 

Слојеви 

Графички приказ 

Координате Размера 

Падајући мени 
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 (падајући мени Layer), где је могуће одабрати тип податка који се жели 

учитати. Овим се отвара нови прозор за додавање новог векторског слоја: 

 

Слика 2. Додавање новог векторског слоја 

Избором Source → Browse наћи фолдер D:\GIS Vežbe, одабрати фајл coastline.shp и 

додати овај слој притиском на дугме Add. На радној површини сада треба да се 

виде обриси континената, пошто слој coastline приказује границу између копна и 

мора. 

На исти начин додати слојеве, populated_places.shp, airports.shp, rivers.shp и 

countries.shp. У прозору  Layers ће се након овог приказати следеће: 

  

Слика 3. Учитани слојеви у QGIS-у 

Поред назива сваког слоја постоји симбол који означава који тип објеката тај слој 

садржи: слојеви airports и populated_places садрже тачкасте објекте (point), слојеви 

rivers и coastline садрже линије (line) док слој countries садржи површине (polygon). 

Видљивост слоја 

Врста слоја 
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Слој који је видљив означен је у пољу испред ознаке врсте слоја и имена слоја. 

Проверити функцију укључивања и искључивања видљивости слоја. 

Уколико је слој изнад видљив, сакрива приказ елемената са слојева који су испод 

њега. Редослед слојева се мења превлачењем слоја мишем (означи се слој 

притиском на леви тастер миша који се држи све док се померањем миша не 

постави слој на жељено место) изнад или испод жељених слојева. Подесити 

слојеве да буду следећим редоследом: airports, populated_places, rivers, coastline,  

countries. Наместити слој coastline да буде невидљив. 

Подешавање особина слојева 

Начин на који ће бити приказан садржај просторних елемената неког слоја на 

графичком приказу се може подешавати. Стил приказа се подешава кроз особине 

слоја (Layer Properties). Двоструким кликом миша на назив слоја се отвара ставка 

Properties. Отворити Properties за слој countries. 

 

Слика 4. Подешавање стила приказа за слој countries 

Са леве стране прозора Properties одабрати ставку Symbology. Ту се може одабрати 

боја којом ће бити офарбана површина полигона или се може одабрати нека 

понуђена испуна (боја са шрафуром итд.). Са клизачем Opacity се може дефинисати 

и мера провидности слоја. Испробати ове функције. Подесити испуну за слој 

countries по жељи. 
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На исти начин подесити боју и дебљину линије за слој rivers. Подесити боју и 

величину симбола за слој populated_places. За слој airports одабрати понуђен 

симбол за аеродром. 

Име слоја на панелу Layers се формира према имену учитаног shp фајла. У случају 

потребе, име слоја може да се промени. Левим тастером миша се означи слој. 

Притиском на десни тастер миша добија се мени, на коме се одабере ставка 

Rename.   

Напомена: Променом имена слоја се не мења назив учитаног shp фајла. Међутим,  

промењено име за тај слој ће се појавити и у легенди карте, уколико ће она бити 

одштампана из снимљеног пројекта. 

 Снимити изглед екрана. Екран се снима притиском на дугме PrtScr на 

тастатури. Снимљена слика се може залепити у MS Word документ 

функцијом Paste. Сачувану слику приложити у елаборат вежбања. 

Уклањање слоја 

Уколико неки слој више није потребан у приказу, он се може уклонити. За 

уклањање је потребно означити слој који се уклања. Означени слој се уклања 

притиском на дугме   из заглавља прозора Layers.  

Напомена: Подаци које садржи уклоњен слој ће и даље остати присутни на диску 

рачунара, само неће више бити укључени у пројекат са којим се тренутно ради. 

Снимање пројекта 

Распоред слојева, боје, транспарентност и друга подешавања се могу сачувати 

снимањем пројекта. На овај начин се снима поглед на податке који су садржани у 

shp фајловима. Уколико дође до промена у shp фајловима који су укључени и у 

неки други пројекат, то ће се одразити и на приказу података у овом пројекту. На 

пример, ако неко обрише Аустралију из shp фајла countries, Аустралија неће 

постојати ни у овом вашем пројекту. 

Снимање пројекта се обавља притиском на дугме Save , па се затим одабере 

место и назив под којим ће се снимити пројекат. Назив пројекта ће имати наставак 

(екстензију) .qgs.  

 Снимити досад урађено као пројекат у фолдер D:\GIS Vežbe\ под називом 

Vežba1_brojindeksa 

Снимљени пројекат се може отворити користећи дугме Open .   
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Напомена: Уколико се пројекат преноси са рачунара на рачунар, осим qgs фајлова 

морају се прекопирати и сви сетови података који су укључени у пројекат. То су тзв. 

„shp“ датотеке, које нису самосталне датотеке. На пример, уколико се жели 

прекопирати слој countries на други рачунар, морају се прекопирати минимално 

следеће датотеке: countries.shp, countries.shx, countries.dbf и countries.prj. Најбоље 

је прекопирати све датотеке са истим именом и различитим наставцима. Уколико 

нека од ових датотека недостаје, QGIS ће пријавити грешку или неће моћи уопште 

да отвори податке. 

  



Географски информациони системи - практикум 
П. Бенка, А. Бездан, Р. Земунац, Н. Сантрач 

7 
 

3. Промена размере приказа 

Приликом учитавања података за први слој, за графички приказ ће се поставити 

таква размера, како би био обухваћен цео садржај тог слоја. У каснијем раду се 

често јавља потреба да се промени размера приказа као и границе графичког 

приказа.  У QGIS-у је могуће на више начина променити размеру графичког приказа 

(Zoom). За ту намену је доступно више функција на палети Map Navigation. 

  
 

Слика 5. Садржај траке са алатима Map Navigation 

Крупнија размера (Zoom In): избором ове функције кликом на миш се врши 

приближавање детаљима. Центар новог приказа је место означено мишем. Други 

начин коришћења ове функције је обележавање правоугаоника који ће бити 

приказан у новом приказу (Zoom Window). Означи се један угао жељеног приказа и 

држећи тастер миша се означи простор приказа.  

Ситнија размера (Zoom Out): избором ове функције се врши удаљавање детаља. 

Место означено притиском на леви тастер миша ће бити центар новог приказа. 

Приказ целог пројекта (Zoom Full): избором ове функције ће се изабрати размера 

тако да цео пројекат стане на површину графичког приказа. 

Приказ означеног елемента (Zoom to Selection): избором ове функције врши се 

приближавање појединачном селектованом елементу или групи селектованих 

елемената на графичком приказу. 

Приказ активног слоја (Zoom Layer): избором ове функције ће се одредити таква 

размера да цео активни слој буде приказан на радној површини. 

Претходни приказ (Zoom Last): приказује се последњи приказ пре тренутног. 

Нови поглед на мапу (New Map View): овај алат опонаша главни прозор графичког 

приказа. Користи се када је потребно истражити (увеличати) неки део садржаја 

графичког приказа, а да се при томе не мења размера у главном прозору. 

Освежи приказ (Refresh): освежава се тренутни приказ. 

Померање тренутног приказа (Pan Map): избором ове функције помера се центар 

активног приказа без промене размере. 

Pan Map 

Zoom In 

Zoom Out 

Zoom Full  Zoom to Layer  Zoom Last Refresh 

Zoom to Selection  New Map View 
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Промена размере (Zoom In / Zoom Out) се може још извршити окретањем точкића 

на мишу. Притиснут точкић уз померање миша помера тренутни приказ (Pan Map). 

 Отворити снимљени пројекат Vežba1_brojindeksa и проверити све набројане 

функције промене размере и померања приказа. 
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4. Приказ атрибутне табеле слоја 

Атрибутна табела за активни слој се приказује притиском на дугме . Атрибутна 

табела садржи додатне информације о објектима приказаним на активном слоју. 

Отворити атрибутну табелу за слој rivers. 

 

Слика 6. Изглед прозора атрибутне табеле слоја rivers 

За сваки објекат приказан на слоју постоји један ред у атрибутној табели. Број 

колона у табели зависи од података који се желе сачувати за сваки објекат. У 

атрибутној табели за слој rivers постоји више поља. Поље name садржи назив реке 

коју приказује повезана линија. Кликом на назив поља у заглављу табеле се сви 

записи сортирају по том запису. Поновни клик сортира поља у обрнутом редоследу. 

Сортирати табелу слоја rivers према називу (name) и пронаћи реке из нашег 

окружења. 

 Снимити изглед екрана. 

Кликом на број лево од реда се означи (селектује) тај ред. Више редова може бити 

истовремено означено (селектовано) тако што се мишем означи први ред из групе, 

затим  се, држећи тастер Shift на тастатури мишем означи последњи ред. На овај 

начин се означе сви редови између ова два. Уколико се жели означити више 

редова који нису један испод другог, користи се комбинација левог тастера миша и 

дугме Ctrl са тастатуре. Притиском на дугме  се поништва означавање 

(селекција).  

 Отворити пројекат Vežba1_brojindeksa и проверити набројане начине 

означавања (селектовања) у атрибутној табели.  
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Притиском на дугме , графички приказ ће се зумирати тако да се прикаже цео 

означени (или више њих) објекат. Проверити рад ове функције. Притиском на 

дугме , приказаће се означени објекти, али без промене размере. Притиском 

на дугме  означени редови у табели се копирају у clipboard. Копирањем 

садржаја clipboard-а у Excel, Calc или други софтвер за рад са табеларним подацима 

могу се ови подаци даље обрађивати. Притиском на дугме  може 

се одабрати да ли да се виде сви записи, само селектовани записи, само записи 

објеката видљивих на графичком приказу или само измењени и нови записи. 

 На отвореном пројекту проверити ове функције. 

Филтрирање атрибутне табеле 

Поглед на атрибутну табелу се може филтрирати тако да буду приказани само 

записи који одговарају по неком критеријуму.  

Отворити атрибутну табелу за слој airports. Притиском на дугме  

затим на Field Filter може се одабрати поље у табели по коме ће се извршити 

филтрирање. Одабрати поље type. У прозору испод табеле уписати small и 

потврдити притиском Enter на тастатури.  

 

Слика 7. Филтрирање атрибутне табеле 

У табели ће се приказати само записи који у пољу type садрже текст small.  

 Снимити изглед екрана.  

Притиском на дугме  се поново приказују сви записи.  
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Проверити функцију Field Filter са другим вредностима садржаја и са другим 

пољима у атрибутној табели на слоју airports у снимљеном пројекту 

Vežba1_brojindeksa. 

Притиском на дугме  и затим на Advanced Filter (Expression) 

добија се напредна могућност филтрирања атрибутне табеле. Овде се добијају 

много веће могућности које ће бити илустроване једним примером: у прозор 

Expression уписати следеће: "type" = 'military' or "type" = 'small' 

 

Слика 8. Прозор за напредно филтрирање табеле 

Овај упит преведен на "обични" језик гласи: прикажи све записе код којих је поље 

type једнако military или поље type једнако small. Упит се потврди притиском на 

дугме ОK и у атрибутној табели ће бити приказани аеродроми типа small и типа 

military. Користећи овај начин филтрирања могуће је приказ у табели филтрирати 

по више критеријума над различитим пољима у табели. 

 Снимити изглед екрана са филтрираном табелом 
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5. Селекција записа у табели коришћењем упита 

Слично филтрирању приказа атрибутне табеле, записе у табели је могуће 

селектовати (изабрати, означити) и коришћењем упита (Expression). Прозор за ову 

селекцију се покреће притиском на дугме .  

 

Слика 9. Прозор за селекцију у табели коришћењем упита 

Као помоћ при изради упита могу се користити већ понуђене функције и поља у 

средњем прозору. Притиском на  поред Fields and Values добија се списак поља 

отворене атрибутне табеле. У случају атрибутне табеле за слој airports добије се 

листа постојећих поља. Могући садржај тог поља се може добити функцијом Load 

Values – дугме: All Unique.  

 

Слика 10. Постављање упита користећи садржај поља у атрибутној табели 
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Извршити селекцију аеродрома типа small или military. 

 Снимити екран. 

Отворити атрибутну табелу за слој populated_places. Селектовати градове са више 

од 10 000 000 становника (поље POP_OTHER садржи податке о броју становника) 

 Снимити екран. 

Селектовати градове из Индије са више од 10 000 000 становника (назив државе 

садржи поље SOV0NAME). За спајање два услова, у случају када оба морају бити 

испуњена, користи се логички оператор AND. 

 Снимити екран, направити табелу са добијеним резултатима. 

Приказати селектоване градове на графичком приказу. 

 Снимити екран. 
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6. Додаци у графичком приказу 

На графичком приказу могу да се поставе и додатни садржаји као што су 

координатна мрежа, размерник, знак севера итд. 

Приказивање координатне мреже 

Приказ координатне мреже се омогућује из падајућег менија, ставка View, затим 

Decorations па ставка Grid. 

 

Слика 11. Изглед прозора за постављање координатне мреже 

У прозору који се отвори треба означити кућицу Enable grid. Потребно је 

дефинисати интервал мреже, да ли ће мрежа бити приказана у виду линија или ће 

бити само темена мреже означена симболом, да ли се жели испис координата 

(Draw Annotation) и друго.  

Отворити пројекат Vežba1_brojindeksa и проверити разне могућности приказа 

координатне мреже. 
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Приказ размерника 

Приказ размерника се омогућује из падајућег менија, ставка View, затим 

Decorations па ставка Scale Bar.  

 

Слика 12. Изглед прозора за приказ размерника 

У прозору који се отвори треба означити Enable Scale Bar. У овом прозору може да 

се одабере позиција размерника, стил приказа, фонт, боја, величина итд. 

Испробати разне опције приказа размерника. 
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Приказ знака за правац севера 

Приказ знака за север се омогућује из падајућег менија, ставка View, затим 

Decorations па ставка North Arrow. Треба означити Enable North Arrow. 

 

Слика 13. Изглед прозора за приказ знака за правац севера. 

Проверити опције приказа знака за север. 

 Након одабира координатне мреже, размерника и знака север, снимити 

екран. 

Напомена: приказ квадратне мреже, размерника и знака за север се односи само 

на графички приказ. Када се жели приказ ових елемената на одштампаној карти, 

онда се ови елементи дефинишу кроз Print Layout, део QGIS-а кроз којим се 

дефинише изглед одштампане карте. Рад са Print Layout-ом ће бити обрађен у 

једној од наредних вежби. 
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7. Идентификација објеката  

На графичком приказу је могуће прочитати податке из базе за изабрани објекат. 

Пре покретања ове функције треба означити слој за који ће се узимати 

информације. Функција идентификације се покреће притиском на дугме  

(Identify Features). Активирањем ове функције курсор мења облик у стрелицу са 

словом i. Кликом на одговарајући објекат (тачку, линију или површину) на 

активном слоју у прозору Identify Results се приказују информације о одабраном 

објекту. Пример: приказани подаци помоћу функције Identify за аеродром Сурчин. 

 

Слика 14. Садржај прозора Identify Results за аеродром Никола Тесла у Сурчину 

Проверити рад функције Identify. Како би се прочитале информације за објекте на 

другим слојевима, у приказу слојева је потребно променити активни слој.  

 Снимити екран са одабраним информацијама за неки аеродром. 

Напомена: подразумеван начин рада функције Identify је да приказује податке 

само за активни слој. Овај начин приказа је могуће променити у путем опције 

Mode,  тако да буде омогућен приказ и за објекте на свим слојевима који се налазе 

испод означеног места курсором. Проверити и ове могућности функције Identify. 
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8. Исписивања ознака на графичком приказу (Labels) 

На графичком приказу се за приказане просторне ентитете (тачка, линија, полигон) 

могу исписивати ознаке које се читају из атрибутне табеле (нпр. називи приказаних 

елемената). 

Отворити пројекат Vežba1_brojindeksa. У пројекту одабрати слој countries као 

активан слој. Притиском на десни тастер миша се отвара мени и одабрати ставку 

Properties. У прозору који се отвори одабрати ставку Labels. Исписивање ознака се 

омогућује означавањем ставке Single Labels. У понуђеним пољима атрибутне 

табеле одабрати поље name_long. Одабрати фонт по жељи, укључити Bold и 

одабрати величину слова 15. Одабрати боју слова по жељи и избор потврдити са 

ОK. 

Променом размере се неке ознаке губе, како би оне могле бити исписане у 

постављеној величини. У поставкама се може одабрати да се ознаке престану 

исписивати када именилац размере пређе неку вредност. За проверу ове 

могућности на означеном слоју countries отворити Properties и одабрати ставку 

Rendering (унутар ставке Labels). Означити ставку Scale dependent visibility и у поље 

 (Minimum scale) уписати вредност 5000000 (што заправо представља 

максималну вредност имениоца до које ће се ове ознаке исписивати). Потврдити 

избор са ОK. Проверити функционисање мењањем размере приказа (zoom-а). 

 

Слика 15. Исписивање назива за слој countries 
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На графичком приказу приказати подручје са државама бивше Југославије. 

Посматрати положај ознаке за Хрватску (пада на подручје БиХ због облика подручја 

Хрватске). Како би ознака падала преко подручја државе, одабрати ставку 

Placement унутар ставке Labels. Унутар опције Mode, одабрати ставку Horizontal. 

Проверити ефекат. Испробати и друге могућности исписивања ознака (Buffer, Mask, 

Shadow, итд.) 

 Снимити екран са исписаним називима државама за жељени регион. 

Постоји могућност исписивања и садржаја више поља као ознаке. За активни слој 

означити слој airports и отворити прозор Labels. Омогућити приказ ознака за овај 

слој. Садржај ознаке дефинисати преко израза притиском на дугме . У 

дијалогу исписати израз  "name" + ',' + "abbrev". Овако формиран израз ће 

омогућити испис назива аеродрома и скраћеницу који ће бити одвојени зарезом. 

Изабрати фонт, боју, величину итд. и потврдити избор. Проверити шта се исписује 

на графичком приказу. Како би побољшали приказ и исписали назив у једном а 

скраћеницу у другом реду, одабрати ставку Formatting и у поље Wrap on character 

уписати зарез (,). Овим ће исписивање ознаке прећи у нови ред на месту сваког 

зареза. Проверити ефекат ове акције. 

У ставци Placement подесити да се ознаке исписују 2 mm испод симбола аеродромa 

(Offset from Centroid, одабере се позиција и колико да буде одмакнут текст). 

Подесити да се ознаке не исписују код размере ситније од 1 : 2 000 000 (опција 

Rendering, за Minimum scale уписати 2000000). Променом размере се примећује да 

испис престаје код размера ситнијих од 1 : 2 000 000, али симбол аеродрома се и 

даље види. Могуће је подесити да се код ситних размера не приказује ни симбол 

аеродрома. То се постиже на следећи начин: отворити Properties од слоја airports. 

Одабрати ставку Rendering и означити Scale Dependent Visibility и уписати вредност 

2000000 за Minimum (exclusive).  

 Снимити екран изабраног подручја где се виде ознаке држава и аеродрома. 

За слој rivers подесити исписивање ознака. Одабрати поље name за исписивање 

ознака. Ставка Placement, за Mode одабрати Curved како би ознака пратила линију 

реке. Ставком Repeating Labels (унутар Placement) се дефинише учесталост исписа 

ознаке. Подесити по свом нахођењу ознаке за реке.  

 Снимити екран са одабраним регионом. 
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9. Подешавање картографске пројекције 

С обзиром на то да је површ Земље закривљена, ако се карактеристичне тачке са 

земљине површи желе приказати у равни (карта или монитор рачунара) морају се 

на неки начин пресликати са закривљене површи у раван. Математичка законитост 

по којој се тачке са закривљене површи пресликавају у површ равни се називају 

картографске пројекције. При томе су неизбежне деформације у приказу. Постоји 

много дефинисаних пројекција у зависности од тога које ће се деформације 

допустити, која површ се користи као пројекциона или за које подручје на 

површини Земље ће се користити одређена пројекција. QGIS омогућује приказ 

просторних података у различитим пројекцијама. Како би све било коректно 

приказано, за сваки сет просторних података (тзв. shp датотеке) мора бити јасно 

дефинисан координатни систем и пројекција. Ови подаци, за поједине shp датотеке 

су садржани у  датотеци са наставком .prj, а са истим именом као што је и име .shp 

датотеке. QGIS омогућује истовремени приказ различитих shp датотека са 

подацима у различитим пројекцијама, чак је могуће да тренутни приказ буде у 

пројекцији у којој није ниједна shp датотека која се приказује.  

За вежбу у којој ће бити демонстриране ове могућности потребно је отворити нови 

пројекат. У овај пројекат додати слојеве coastline и graticules_30.  

Наместити размеру (Zoom) тако да се види цео садржај пројекта. Слој coastline 

оцртава облик континената док слој graticules_30 приказује координатну мрежу за 

географску ширину и дужину са размаком 30 степени. Почетни приказ је приказ без 

пројекције, тј. географске координате су приказане као да је Земља равна плоча - 

мрежа паралела и меридијана формира квадрате. Код овог приказа се географске 

координате третирају као правоугле (Декартове), тако да је размак између 

меридијана и паралела на сваком делу карте исти, иако то на Земљиној површи 

није тако, односно на монитору се види деформисан приказ. 

 Снимити изглед екрана 

Избор картографске пројекције на графичком приказу се започиње притиском на 

дугме  у доњем десном углу радне површине, односно на десној 

страни статусне линије. Овим се отвара прозор особина пројекта, где се ставка CRS 

(Coordinate Reference System) односи на избор елипсоида или сфероида којим се 

апроксимира површ Земље и врсту пројекције у којој ће просторни подаци бити 

приказани. Званично дефинисани CRS поред свог назива имају додељен и 

јединствени EPSG код. 
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Понуђене су три групе CRS: Географски координатни системи, Координатни системи 

у пројекцији и координатни системи дефинисани од стране корисника. Постојећи 

CRS могу лакше да се пронађу користећи Filter. 

 

Слика 16. Подешавање координатног система отвореног пројекта. 

За податке који су претходно учитани (coastline и graticules_30) за предефинисани 

CRS стоји WGS 84 (EPSG:4326). 

У поље филтер укуцати 54012 (EPSG код за World_Eckert_IV пројекцију). У прозору 

Predefined Coordinate Reference System одабрати World_Eckert_IV пројекцију. 

Затворити прозор притиском на дугме ОK. Приказати цео пројекат (Zoom full). Код 

ове пројекције се може приметити да су паралеле остале праве линије, док су 

меридијани закривљене линије. 

 Снимити екран. 

Табела 1. садржи називе и EPSG кодове пројекција које је потребно испитати. 

Анализирати деформације приказа континената и мреже меридијана и паралела за 

сваку пројекцију. 

 За сваки CRS дат у табели направити снимак екрана. 
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Табела 1. Назив пројекције и EPSG код 

редни 
број 

Назив пројекције EPSG 

1 WGS 84 4326 

2 World_Eckert_IV 54012 

3 World_Sinusoidal 54008 

4 World_Еquidistant_Cylindrical 54002 

5 North_Pole_Azimuthal_Equidistant 102016 

6 World_Azimuthal_Equidistant 54032 

 

За демонстрацију следећих пројекција је потребно отворити нови пројекат. У овај 

пројекат треба учитати слојеве countries и graticules_1. Зумирати приказ тако да се 

виде земље југоисточне Европе (Србија и окружење). Отворити прозор за избор 

CRS. За разлику од неких претходних верзија QGIS-а, трансформација „у лету“ (on 

the fly) се сада извршава аутоматски. Пронаћи пројекцију WGS 84 / UTM zone 34N 

(EPSG:32634). Посматрати како се мења облик граница Србије и мрежа меридијана 

и паралела коришћењем ове пројекције.  

 Снимити изглед екрана. 

На исти начин проверити приказ када се одабере пројекција ETRS89 / UTM zone 34N 

(EPSG:25834). Ова пројекција је званична пројекција која се користи за државни 

премер на територији Републике Србије. 

 Снимити изглед екрана. 

Учитане податке приказати у пројекцији MGI 1901 / Balkans zone 7 (EPSG:3909). Ова 

пројекција, поред MGI 1901 / Balkans zone 6 (EPSG:3908) се донедавно користила за 

државни премер на територији Србије. Многи планови и топографске карте су 

израђени у овим пројекцијама. 

 Снимити изглед екрана. 
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10. Мерење на графичком приказу 

Приказани просторни подаци на графичком приказу омогућују одређена мерења.  

За проверу могућности мерења, у нови пројекат учитати слојеве countries, rivers и 

populated_places. Размеру и центар приказа наместити тако да се види Србија са 

околним земљама 

Мерење координата тачака 

Најједноставније је очитавање координата положаја курсора. Тренутне координате 

курсора се могу очитати у прозору испод графичког приказа:  

 

Слика 17. Приказ координата курсора у прозору у саставу статусне линије 

Координате ће бити приказане у изабраном координатном систему (CRS). Уколико 

је то неки географски координатни систем, као што је WGS 84 (EPSG:4326), 

координате ће бити геодетска дужина и геодетска ширина.  

Очитати геодетске координате Новог Сада и околних градова. Као помоћ при 

препознавању градова може се користити функција Identify. 

 Направити табелу са добијеним подацима са 10 места у околини Новог Сада. 

Променити пројекцију у ETRS89 / UTM zone 34N (EPSG:25834). Поново очитати 

координате истих градова.   

 Унети и ове нове податке у табелу. 

У првом случају су очитане геодетске координате (изворни подаци су дати као 

геодетска дужина и геодетска ширина). У другом случају су очитане правоугле 

координате E и N у државном координатном систему – УТМ пројекција. 

 

Мерење растојања 

Мерење растојања се покреће притиском на дугме . Растојање које се мери 

је праволинијско, а могуће је мерити и изломљену линију. Означавају се крајње и 

преломне тачке линије мишем.  У прозору за мерење ће се појавити дужина сваког 

сегмента линије и укупно растојање. Мерење се завршава притиском на десни 

тастер миша. 
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Слика 18. Прозор са резултатима мерења растојања 

 Измерити растојања од Новог Сада до: Суботице, Сегедина, Београда, 

Темишвара. Направити табелу са добијеним подацима. 

Мерење површине 

Мерење површине се покреће притиском на  ставку Measure Аrea (стрелица поред 

Measure Line па Measure Area) 

 

Слика 19. Избор величине за мерење 

Мишем се означавају углови површине која се жели измерити. Мерење се 

завршава притиском на десни тастер миша. 

 Измерити површину која се добије када се споје Нови Сад, Суботица, 

Сегедин, Темишвар и Београд. 

Мерење угла 

Угао се мери бирањем три тачке: тачка на левом краку, теме и тачка на десном 

краку. Мерење се покреће притиском на ставку Measure Angle. Мишем се означи 

тачка на левом краку, теме и тачка на десном краку (овим редоследом) резултат је 

угао дат у степенима у декадном облику.  

 Измерити угао где је Нови Сад теме, Суботица на левом краку, а Београд на 

десном краку 

Напомена: За коректно мерење потребно је да буде подешена одговарајућа 

конформна картографска пројекција, тада нема деформација углова. 
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11. Селекција објеката на графичком приказу 

Селекција (означавање) појединих објеката се може, поред селекције у атрибутној 

табели, извршавати и на екрану графичког приказа. Селекција може бити 

појединачна или се може означити и више објеката истовремено. За селекцију се 

на палети алата користи икона . Ова икона ће бити доступна тек када буде 

неки слој одабран као активни слој. 

Појединачна селекција 

Учитати претходно снимљен пројекат Vežba1_brojindeksa. Поставити као активан 

слој populated_places. Одабрати алат за селекцију . Избором алата се 

курсор миша мења у следећи облик: . Пронаћи тачкицу која означава неки град 

на слоју populated_places. Врх стрелице курсора се постави на објекат и објекат се 

означи притиском на леви тастер миша. Селектовани објекат промени боју (у 

QGIS-у је подразумевано постављено на жуту боју, али се боја селектованог објекта 

може у подешавањима променити).  

Селекцијом објекта на графичком приказу, истовремено се врши и селекција 

припадајућег реда у атрибутној табели. Означити за активан слој airports. За 

активни слој отворити атрибутну табелу и поставити Filter на Show Selected Features 

. Зумирати на графичком приказу територију Балкана и 

означити неки аеродром. Проверити приказ и информације у атрибутној табели у 

случају означавања појединих аеродрома. Проверити ову функцију и на другим 

аеродромима.  

 Снимити екран са приказаним садржајем атрибутне табеле за произвољни 

аеродром. 

Затворити атрибутну табелу за слој аеродроми. 

Искључивање селекције 

Селекција са свих селектованих објеката се може искључити (Deselect) притиском 

на икону . Притиском на ову икону сва означавања на графичком приказу и у 

атрибутној табели ће бити уклоњена. Овом алатком могуће је извршити 

деселекцију са тренутно активног слоја (Deselect Features from the Current Active 

Layer) или са свих слојева, уколико је селекција вршена на више слојева (Deselect 

Features from All Layers). 
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Одабрати за активни слој rivers и укључити приказ атрибутне табеле. Филтрирати 

приказ само селектованих  објеката у табели. Проверити функцију селекције на 

слоју rivers који садржи линијске објекте. 

 Снимити екран са приказаним садржајем атрибутне табеле за произвољну 

реку. 

Одабрати за активни слој countries и укључити приказ атрибутне табеле. 

Филтрирати приказ само селектованих објеката у табели. Проверити функцију 

селекције на слоју countries који садржи полигоне. 

 Снимити екран са приказаним садржајем атрибутне табеле за произвољну 

државу. 

Појединачна селекција више објеката 

Селекцијом новог објекта брише се селекција претходног објекта. Уколико се жели 

задржати селектовани објекат и да се у скуп селектованих објеката дода нови 

објекат, то се постиже селекцијом новог објекта мишем уз истовремено држање 

тастера Ctrl на тастатури. 

Поновним кликом на већ селектовани објекат се он уклања из скупа селектованих 

објекта. 

Поставити слој populated_places за активни, отворити његову атрибутну табелу и 

поставити Filter на приказ само селектованих објеката. Проверити функцију 

вишеструке селекције применом претходно описаног поступка. 

 Снимити екран са приказом више појединачно селектованих градова. 

Селекција свих објеката унутар правоуганика 

За селекцију објеката унутар правоугаоника се користи иста икона као и за 

појединачно означавање. Поставити слој populated_places за активан слој, 

отворири атрибутну табелу и поставити Filter за приказ само селектованих објеката.  

Поставити врх стрелице курсора на једно теме замишљеног правоугаоника. 

Притиснути леви тастер миша, и док је тастер притиснут, померањем миша 

означити подручје унутар којег се желе одабрати објекти.  

 Проверити рад ове функције. 

Проверити шта се дешава када се уз означавање правоугаоником држи притиснут 

тастер Ctrl на тастатури. 
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Селекција свих објеката унутар полигона 

За позивање ове функције притисне се падајући мени поред дугмета за означавање 

. Овим се добија додатна палета функција за селекцију: 

 

Слика 20. Позивање функције селекције помоћу полигона 

Од понуђених опција одабрати алат Select Features by Polygon. На подручју где се 

желе означити објекти мишем и левим тастером на мишу означити темена 

полигона. Полигон ће бити означен црвеном бојом. Означавање полигона се 

завршава притиском на десни тастер миша. 

 

Слика 21. Селекција објеката унутар полигона 

Проверити означавање коришћењем ове функције на слоју populated_places. 

 Снимити екран  
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Селекција објеката коришћењем "Freehand" опције. 

Одабрати алат за означавање Select Features by Freehand. Ставити курсор на 

жељено место и држећи леви тастер миша нацртати површину унутар које се желе 

означити објекти: 

 

Слика 22. Селекција објеката путем "Freehand" полигона. 

Селекција објеката унутар круга 

Одабрати алат Select Features by Radius. Курсор миша ставити на центар 

замишљеног круга. Држећи леви тастер миша и померањем миша означити круг 

унутар кога се желе селектовати објекти. 

Проверити како ови претходно описани начини селекције раде на слојевима са 

линијама (слој rivers) или са полигонима (слој countries). 
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12. Израда слоја тачака из текстуалног фајла 

Уколико се жели израдити нови слој са тачкама које су прикупљене изван QGIS-а 

(нпр. тачке које су измерене коришћењем GNSS пријемника), овај слој се може 

израдити ако су познате координате свих тачака. Координате могу бити 

елипсоидне (геодетска ширина и геодетска дужина) или могу бити координате на 

пројекционој површи (нпр. X и Y у Гаус Кригеровој пројекцији MGI 1901 / Balkans 

zone 7 (EPSG:3909)). Пре израде оваквог слоја потребно је припремити текстуалну 

датотеку са свим потребним подацима. Неопходан број података за једну тачку је 

ID тачке (најбоље бројчана ознака) и обе координате тачке. Први ред у текстуалној 

датотеци је заглавље, односно означава називе података и њихов редослед у 

једном реду. Остали редови садрже податке за тачке, један ред су подаци за једну 

тачку. Одвајање података (ID, ширина, дужина ...) може се извршити на више 

начина: 

CSV – (Comma Separated Value) – код овог начина писања података су поједини 

подаци раздвојени зарезима. Пример дела једне CSV датотеке: 

rb,gsirina,gduzina,naziv 
1,45-15-31,19-50-18,NSad 
2,45-18-01,19-44-54,Rumenka 
 
ТAB – Раздвајање се може извршити табулаторима. Пример дела датотеке са TAB 
раздвајањем: 
 
rb gsirina gduzina naziv 
1 45-15-31 19-50-18 NSad 
2 45-18-01 19-44-54 Rumenka 
 
Овако формирана датотека је прегледнија.  
 
Празно место – Између података се остави празно место (space): 
 
rb gsirina gduzina naziv 
1 45-15-31 19-50-18 NSad 
2 45-18-01 19-44-54 Rumenka 
 
Ово су највише коришћени начини раздвајања али QGIS дозвољава коришћење и 
других знакова као што су двотачка (:), тачка-зарез (;) или неки трећи знак. При 
избору знака за раздвајање треба бити опрезан, како се не би добили неочекивани 
резултати. На пример, ако се уз тачку уноси неки текстуални податак који може да 
садржи празно место, а за раздвајање се користи празно место, то ће пореметити 
унос података или, у најбољем случају, скратити низ података за унос. Исто важи и 
за остале знакове за раздвајање.  
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Напомена: За припрему оваквих датотека обавезно користити текст едиторе као 
што је Notepad. Не препоручује се коришћење текст процесора као што су MS Word, 
Wordpad или слични, пошто они користе и одређене скривене кодове у тексту, за 
форматирање текста. 
 

Израда слоја тачака из задатих елипсоидних координата 

Површ земље се у геодезији апроксимира најприближнијим математички 

дефинисаним телом – елипсоидом. Положај тачке на елипсоиду се може 

дефинисати путем геодетске ширине и геодетске дужине: 

 

Слика 23: Положај тачке на елипсоиду дефинисан путем елипсоидних координата 

При томе треба познавати на који елипсоид се односе подаци. Често се на овакав 

начин уносе тачке снимљене путем GNSS-а. Геодетска ширина и дужина за тачку 

снимљену GNSS пријемником изворно су дате у односу на елипсоид WGS 84. 

С обзиром на то да су геодетска ширина и дужина угловне мере, оне се изражавају 

у степенима. Делови координата мањи од степена се могу изразити као децимални 

делови степена (тзв. декадни запис) или путем минута и секунди. Иако QGIS 

прихвата оба записа, корисно је знати да се декадни запис угла може добити по 

једноставној формули: 

 екадни запис  Степени 
минуте

  
 
секунде

    
 

Уколико се координате уносе у облику степени, минуте, секунде (енглеска 

скраћеница: DMS), између броја степени, минута и секунди треба убацити неки 

знак (другачији од знака за раздвајање података). Овде се може користити знак 

минус (-). Пример: за угао 45° 15´ 31˝ може се уписати 45-15-31. 
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За даљи рад на овој вежби, потребно је припремити текстуалну датотеку. За израду 

текстуалне датотеке користити Notepad. У текстуалној датотеци треба уписати дате 

податке, а за раздвајање два податка у реду користити табулатор. Текстуалну 

датотеку снимити под именом tacke_DMS.txt у радни фолдер на D диску. 

Садржај текстуалне датотеке:  

rb gsirina gduzina naziv 

1 45-15-31 19-50-18 NSad 

2 45-18-01 19-44-54 Rumenka 

3 45-14-41 19-43-10 Futog 

4 45-14-16 19-37-20 Begec 

5 45-16-38 19-34-08 Glozan 

6 45-21-33 19-35-38 BPetrovac 

7 45-24-03 19-35-08 Kulpin 

8 45-26-58 19-37-10 RSelo 

9 45-27-08 19-41-21 Zmajevo 

10 45-24-36 19-42-07 Stepanovicevo 

11 45-20-55 19-43-39 Kisac 

12 45-26-13 19-48-30 Sirig 

13 45-22-08 19-48-08 Cenej 

14 45-24-40 19-53-32 Temerin 

15 45-22-16 19-52-29 Bjarak 

 

Покренути QGIS. У падајућем менију за Settings → Options одабрати ставку CRS 

Handling (подешавање координатног система). Под ставком CRS for Layers изабрати 

опцију Prompt for CRS. На овај начин ће се при изради слоја из текстуалног фајла 

добити упит у коме ће се поставити координатни систем у коме су дати подаци. 

 

Слика 24. Опције за дефинисање координатног система за нове слојеве 



Географски информациони системи - практикум 
П. Бенка, А. Бездан, Р. Земунац, Н. Сантрач 

32 
 

Након тога се може приступити додавању новог слоја из текстуалне датотеке. 

Дугме за додавање слоја тачака из текстуалне датотеке има изглед:  налази 

се на палети са осталим иконама за рад са слојевима или се позове кроз Data 

Source Manager → Delimited Text. Покретањем ове функције отвара се нови прозор: 

 

Слика 25: Прозор за учитавање тачака из текстуалне датотетке 

Притиском на дугме Browse се улази у дијалог за отварање текстуалне датотеке. 

QGIS сам понуди назив новог слоја, али се то име слоја у пољу Layer name може 

променити у жељено. Избор начина раздвајања се врши означавањем постојећих 

опција. Да ли је раздвајање података добро, може се видети у Sample Data. Ту су 

још опције којима дефинишемо да ли постоји заглавље у нашој текстуалној 

датотеци, да ли се за децимално раздвајање користи зарез итд. У делу Geometry 

definition треба означити Point coordinates и означити који податак у заглављу 

означава X координату (у овом случају геодетску дужину: gduzina) и Y координату 

(gsirina). Пошто су координате дате у облику степени, минута и секунди, треба још 

означити и ставку DMS coordinates. Притиском на дугме Add се формира слој са 

тачкама. Пре приказивања новог слоја на графичком приказу, с обзиром да није 

дефинисан координатни систем, отвара се прозор у коме се он дефинише. За ову 

датотеку потребно је одабрати WGS 84 (EPSG:4326). 
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Отварањем атрибутне табеле може се проверити да ли су сви подаци о тачкама 

унети и у атрибутну табелу. За позиционирање тачке се користе подаци означени у 

X field и Y field, међутим сви унети подаци за неку тачку у текстуалном фајлу ће бити 

учитани у одговарајућу ћелију атрибутне табеле.  

Како би се овај слој сачувао за даље коришћење, слој треба снимити у одговарајућу 

shp датотеку. Десним кликом миша на формираном слоју се отвара мени где се 

бира ставка Export → Save Feature As..., па се слој сними на жељено место на диску 

рачунара. Снимити формирани слој тачака у shp датотеку у радни фолдер под 

именом Tacke_DMS. 

 

Слика 26. Снимање слоја као shp датотеке 

Након учитавања тачака, за учитане тачке путем функције Identify проверити који су 

подаци учитани за поједине тачке. Отворити атрибутну табелу за новоформирани 

слој. Анализирати учитане податке у атрибутној табели. Путем селекције појединих 

редова из атрибутне табеле проверити на који тачкасти објекат се односе подаци 

из табеле.  

За следећи део вежби треба формирати нову текстуалну датотеку са следећим 

подацима: 
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rb,gsirina,gduzina,naziv 

1,45.25861111,19.83833333,NSad 

2,45.30027778,19.74833333,Rumenka 

3,45.24472222,19.71944444,Futog 

4,45.23777778,19.62222222,Begec 

5,45.27722222,19.56888889,Glozan 

6,45.35916667,19.59388889,BPetrovac 

7,45.40083333,19.58555556,Kulpin 

8,45.44944444,19.61944444,RSelo 

9,45.45222222,19.68916667,Zmajevo 

10,45.41000000,19.70194444,Stepanovicevo 

11,45.34861111,19.72750000,Kisac 

12,45.43694444,19.80833333,Sirig 

13,45.36888889,19.80222222,Cenej 

14,45.41111111,19.89222222,Temerin 

15,45.37111111,19.87472222,Bjarak 

 

За израду текстуалне датотеке користити Notepad. У текстуалној датотеци треба 

уписати дате податке, а за раздвајање два податка у реду користити зарез (запету). 

Текстуалну датотеку снимити под именом Tacke_DEG.txt. 

 

Слика 27. Учитавање датотеке код које су подаци раздвојени зарезима (CSV) 
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У истом пројекту затим, по претходно описаном поступку, формирати нови слој 

тачака користећи текстуалну датотеку са називом Tacke_DEG.txt. За раздвајање 

означити ставку CSV. Код дефинисања података о координатама искључити ставку 

DMS coordinates, пошто су у овој датотеци координате дате у декадном запису. И за 

ову датотеку је потребно одабрати WGS 84 (EPSG:4326) координатни систем. 

Отворити атрибутну табелу за новоформирани слој. Путем селекције у табели и 

селекције на графичком приказу анализирати учитане податке. Снимити 

новоформирани слој у shp датотеку, у радни фолдер под именом Tacke_DEG. 

Укључивањем и искључивањем видљивости слоја или мењањем редоследа слојева 

проверити да ли се учитане тачке поклапају, с обзиром да се ради о истим тачкама 

али са различито записаним координатама. 

 

Израда слоја тачака из задатих правоуглих координата 

Ради израде топографских планова или карата, које су приказ Земљине површи у 

равни, тачке са закривљене површи Земље се морају пресликати у раван 

топографске подлоге. При томе се пресликавање врши директно у раван или на 

површ цилиндра или конуса, које се могу развити у раван без додатних 

деформација. Ово пресликавање се врши путем одговарајуће картографске 

пројекције. У равни топографске карте или плана, свака тачка је дефинисана путем 

правоуглих координата. У Србији се као званична пројекција за државни премер 

користи УТМ пројекција. Територија Србије се налази у 34. зони УТМ пројекције. У 

УТМ пројекцији се користе правоугле координате. Пројекција екватора представља 

E осу, а пројекција централног меридијана за 34. зону представља N осу. 

Потреба за оваквим учитавањем тачака може да се јави уколико се користе подаци 

геодетског снимања на терену. Координате снимљених детаљних тачака ће бити 

дате у државном координатном систему.  

За овај део вежбе треба формирати нову текстуалну датотеку, према претходно 

описаном упутству са следећим подацима:  

rb E N naziv 

1 408856 5012336 NSad 

2 401866 5017070 Rumenka 

3 399503 5010934 Futog 

4 391860 5010288 Begec 

5 387752 5014743 Glozan 

6 389872 5023812 BPetrovac 

7 389300 5028453 Kulpin 

8 392045 5033807 RSelo 
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9 397502 5034024 Zmajevo 

10 398426 5029317 Stepanovicevo 

11 400318 5022465 Kisac 

12 406795 5032182 Sirig 

13 406205 5024628 Cenej 

14 413317 5029218 Temerin 

15 411885 5024793 BJarak 

 

За овај случај за раздвајање користити једно празно место. Датотеку снимити под 

називом tacke_UTM.txt. Формирање слоја тачака из ове датотеке, када су дате 

правоугле координате је сличан претходно описаном поступку. Отворити нови 

пројекат и покренути формирање слоја из текстуалне датотеке. Одабрати датотеку 

tacke_UTM.txt. За ставку File Format одабрати Custom delimiters и означити кућицу 

Space. За X field треба одабрати колону E, за Y field колону N. Ставка DMS треба да 

буде искључена, пошто су ове координате дужине и оне се не дају у степенима, већ 

су јединице метри. 

Пре приказивања учитаних тачака мора да се дефинише координатни систем 

односно пројекција учитаних података. За ове тачке одабрати пројекцију: ETRS89 / 

UTM zone 34N (EPSG ознака ове пројекције је 25834 – за лакше тражење). Након 

учитавања, учитане тачке снимити у shp датотеку у радни фолдер са називом 

Tacke_UTМ. 

Анализирати учитане тачке и податке у атрибутној табели селекцијом у табели и на 

графичком приказу.  

На крају, укључивањем и искључивањем видљивости слојева проверити 

поклапање тачака из формираних слојева. Проверити вредност координата у 

статусној линији графичког приказа. 

Објашњење: С обзиром да су учитане тачке из два различита координатна система 

(tacke_UTM су у ETRS89/UTM zone 34N, док су tacke_DMS дате u WGS 84) QGIS врши 

пројекцију "у лету", тако да су за tačke_UTM из координата УТМ пројекцији 

прерачунате елипсоидне координате и тако су приказане. Тачке се поклапају, 

пошто се ради о истим тачкама, само је њихова позиција дата у различитим 

координатним системима. 

Из овог примера се јасно може закључити да се могу комбиновати подаци 

снимања путем ГНСС и класичним геодетским методама, само се за свако снимање 

мора тачно дефинисати координатни систем у којем су одређене. 
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13. Геореференцирање скениране карте 

При уношењу просторних података у ГИС се често користе постојеће папирне карте. 

Како би се подаци са папирних карата могли у пуној мери користити у ГИС-у, 

потребно је извршити превођење ових података у дигиталну форму. Популарни 

назив за овај поступак је дигитализација. У поступку дигитализације је потребно 

проћи неколико корака, како би се на крају добили подаци у жељеном облику. 

Дигитализација топографских подлога може да се изврши коришћењем посебног 

хардверског додатка рачунару: дигитајзерске табле или користећи скенирану слику 

топографске подлоге. У оквиру овог практикума ће бити описан поступак 

дигитализације топографске подлоге са скениране карте. Како би се обезбедила 

довољна тачност дигитализованог садржаја, пожељно је користити квалитетни 

скенер и скенирати карту у резолуцији 300 dpi (300 пиксела по инчу) или већој. 

За геореференцирање скениране топографске подлоге потребно је познавати 

координате одређеног броја тачака приказаних на топографској подлози. 

Минималан број познатих тачака зависи од методе трансформације која ће се 

применити код геореференцирања. За најједноставнији модел трансформације, 

неопходно је познавати координате најмање две тачке. При избору познатих 

тачака, на топографским подлогама као најпогодније се могу изабрати тачке 

темена координатне мреже, уколико она постоји. Уколико координатна мрежа није 

приказана на топографској подлози, онда се могу одабрати карактеристичне тачке 

за које је могуће утврдити координате. 

У QGIS-у, алат за геореференцирање се може позвати из падајућег менија Layer → 

Georeferencer. 

Поступак геореференцирања почиње отварањем новог пројекта. За нови пројекат 

се мора одабрати координатни систем, исти који је коришћен при изради карата. 

За вежбу геореференцирања једног листа топографске карте размере 1:25000 

треба одабрати пројекцију MGI 1901 / Balkans zone 7. EPSG код ове пројекције је 

3909. Ово је ознака Гаус Кригерове пројекције, 7. зона, која се у претходном 

периоду користила за државни премер. 

Након дефинисања координатног система, покреће се georeferencer. Овим ће се 

отворити прозор georeferencera. Прво је потребно учитати скенирану карту 

функцијом Open raster . У дијалогу који се затим отвара треба пронаћи датотеку 

378-2-3.tiff у фолдеру D:\GIS vezbe\. Након тога је потребно одабрати координатни 

систем односно пројекцију карте која ће бити геореференцирана. Одабрати MGI 

1901 / Balkans zone 7 (EPSG: 3909). Након овога у прозору геореференцера треба да 

се прикаже одабрана скенирана карта. 
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Слика 28. Приказ скениране топографске карте за геореференцирање 

Следећи корак је додавање референтних тачака, на основу којих ће се извршити 

геореференцирање. За овај пример ће бити коришћена четири темена квадратне 

мреже карте. Координате ових тачака су дате на слици (Слика 28).  
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За додавање референтних тачака се користи функција Add points .  

Након покретања функције Add points, потребно је коришћењем Zoom и Pan 

функција увећати теме квадратне мреже у горњем левом углу карте и што тачније 

означити ову тачку. 

 

Слика 29. Означавање пресека линија квадратне мреже приликом 
геореференцирања 

Означавањем тачке се отвара нови прозор где се уносе координате ове тачке 

(Error! Reference source not found.). Након унетих вредности, овај прозор се затвара 

ритиском на дугме ОК. 

 

Слика 30. Прозор за унос координата означеног темена квадратне мреже 

Потребно је означити и унети координате за све четири тачке. Након додавања 

тачака, следи избор врсте трансформације кроз функцију Transformation settings 

. Овиме се отвара нови прозор: 
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Слика 31. Подешавање трансформације код геореференцирања 

За врсту трансформације одабрати Polynomial 1 (Афина трансформација). Такође је 

потребно одабрати путању и име за нову трансформисану слику карте: Output 

raster: Овде треба одабрати ново име 378-2-3_g.tiff. За Target CRS  треба одабрати 

MGI 1901 / Balkans zone 7 (EPSG: 3909). Уколико се жели да геореференцирана 

карта након овог поступка буде већ учитана у QGIS, треба означити опцију Load in 

project when done. Након тога се подешавања потврде притиском на ОК. 
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Поступак геореференцирања се затим заврши функцијом Start georeferencing . 

Уколико је све коректно урађено, појавиће се прозор који приказује фазу 

геореференцирања. Када се овај прозор затвори, геореференцирање је завршено и 

може се затворити прозор georeferencer-а. При затварању ће се појавити упит да ли 

се желе снимити референтне тачке. Ово може бити корисно уколико се 

експериментише са различитим врстама трансформације. За ову вежбу се избегне 

снимање тачака притиском на дугме Discard.  

Након геореференцирања у радном фолдеру ће се појавити нови фајл 378-2-3_g.tiff 

који је типа GeoTiff. Овај фајл се сада може учитати у ГИС програм без новог 

геореференцирања. Уколико се располаже геореференцираном картом која није у 

GeoTiff формату (обичан Tiff формат), уз ову датотеку у истом фолдеру мора да 

стоји и друга датотека која има исто име, а наставак .tfw. Ово је такозвани world 

фајл, односно датотека која садржи податке где се скенирана карта налази у 

координатном систему. Другим речима, GeoTiff представља датотеку у којој су 

обједињени подаци из обичне tiff датотеке и подаци из tfw датотеке. 

⮚ Снимити екран са геореференцираном картом. 
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14. Дигитализација тачака са геореференциране карте 

Геореференцирана карта из претходне вежбе ће бити искоришћена за 

дигитализацију, односно израду нових слојева, исцртавањем потребних садржаја 

са геореференциране карте. 

Први корак је отварање новог пројекта: у падајућем менију ставка Project → New. 

У нови пројекат се затим учитава геореференцирана карта избором одговарајућег 

дугмета у палети за додавање слојева или избором у менију Layer → Add Layer → 

Add Raster Layer:  

 

Слика 32. Дугме за додавање новог растерског слоја 

Овим се отвара стандардни прозор дијалог Open где се потражи и означи име фајла 

који садржи геореференцирану карту 378-2-3_g.tiff. Након потврде се на 

графичком приказу приказује карта. Померањем миша по карти и праћењем 

координата у статусној линији, координате треба да одговарају координатама 

приказаних тачака у Гаус Кригеровој пројекцији. После овог корака се може 

приступити формирању новог слоја у који ће се смештати дигитализоване тачке. 

Задатак ће бити дигитализација карактеристичних тачака терена у висинском 

смислу – кота, које су приказане на геореференцираној топографској карти. У 

поступку дигитализације ће се у атрибутну табелу уписивати и надморска висина 

дигитализоване тачке. 

Нови слој се може формирати притиском на дугме  на палети за рад са 

слојевима или избором у менију Layer → Create Layer → New Shapefile Layer. Овим 

се отвара прозор где се дефинишу потребни параметри за нови слој. За врсту слоја 

одабрати тачке (Point), за координатни систем одабрати MGI 1901 / Balkans zone 7 

(EPSG: 3909). Приликом дигитализације ће се уписивати и висине дигитализованих 

тачака. Зато треба додати нови атрибут у атрибутну табелу са називом H. За овај 

атрибут дефинисати тип података: Decimal Number, Precision 2 (две децимале) и 

потврдити са Add field to list. Након потврђивања ових параметара отвара се 

дијалог за снимање новог слоја. Нови слој треба снимити под именом 

Kote_brojindeksa.shp. 

Напомена: Поред датотеке са наставком shp, за овај слој се формира још неколико 

датотека са истим именом али са различитим наставцима. За пренос овог слоја на 

друго место, морају се прекопирати сви фајлови са истим именом. 
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Слика 33. Дефинисање параметара за нови слој са тачкама 

Након овог поступка, у списку слојева ће се појавити нови слој са тачкама. За овај 

слој подесити симбол за тачку тако да буде контрастне боје и облика у односу на 

позадину – топографску карту. 

Затим се може почети са дигитализацијом висинских тачака – кота са топографске 

карте. Промене на слоју Kote_brojindeksa  почињу тиме што се овај слој направи 

активним означавањем у списку слојева. Промене (Eдитовање) се омогуће 

притиском на дугме . За додавање нових тачака одабере се дугме  . 

Активирањем ове функције на слој који се мења се додају нови објекти. Курсор на 

графичком приказу ће се променити у . Потребно је приближити (зумирати) 

детаљ на карти и што тачније наместити крстић на коту и притиснути леви тастер 

миша. Означавањем тачке се отвара дијалог за унос података у атрибутну табелу 



Географски информациони системи - практикум 
П. Бенка, А. Бездан, Р. Земунац, Н. Сантрач 

44 
 

 

Слика 34. Дигитализација тачке са скениране карте 

Дигитализована тачка ће се приказати преко скениране карте својим симболом. На 

овај начин дигитализовати и остале висинске тачке – коте са топографске карте. 

Повремено је потребно снимити урађено, притиском на дугме: . Мењање 

садржаја слоја се завршава поновним притиском на дугме  којим је и 

започето едитовање. 

⮚ Снимити екран где се виде дигитализоване тачке. 
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15. Дигитализација полилинија са геореференциране карте 

У истом пројекту у коме су дигитализоване тачке са висинама приступити 

дигитализацији линијских ентитета. Са карте ће се дигитализовати правци 

саобраћајница. Притиском на дугме  или избором у менију Layer → Create 

Layer → New Shapefile Layer се отвара дијалог за формирање новог слоја. За овај 

слој се одабере тип Line (Линија). За координатни систем одабрати MGI 1901 / 

Balkans zone 7 (EPSG: 3909). У атрибутну табелу додати три нова атрибута 

текстуалног типа дужине 20 знакова са називима: врста, од, до. У поље „врста“ ће 

се приликом дигитализације уписивати врста саобраћајница (пруга, асфалтни пут, 

...) у поље „од“ место почетка и у поље „до“ место краја саобраћајнице. 

 

Слика 35. Подешавање параметара за креирање новог слоја са линијама 

Потврдом на ОК се отвара дијалог за избор локације и назива датотека новог слоја 

где ће се узети назив Saobraćajnice_brojindeksa и потврдити са ОК. 

У списку слојева ће се појавити овај нови слој. Одабрати боју линије која ће бити 

видљива на скенираној карти. Након тога се може приступити дигитализацији – 

прецртавању саобраћајница са карте.  
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У списку слојева означити слој са саобраћајницама и притиском на дугме  се 

омогућују промене на слоју. Притиском на дугме  почиње додавање нових 

линија. Покретањем ове функције ће се променити облик курсора. Потребно је 

зумирати приказ како би се прецизно могла прецртати линија одабране 

саобраћајнице са карте. Тачке на линији се бирају притиском на леви тастер миша. 

Линија се завршава притиском на десни тастер миша. Након тога се отвара прозор 

где треба уписати потребне податке у атрибутну табелу. 

 

Слика 36. Унос података у атрибутну табелу за слој саобраћајнице 

Дигитализована линија ће се приказати преко скениране карте. Повремено је 

потребно снимити урађено, притиском на дугме: . Eдитовање слоја се 

завршава притиском на дугме  којим је и започето едитовање. 

⮚ Снимити екран са где се виде дигитализоване саобраћајнице. 
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16. Дигитализовање полигона са скениране карте 

На претходно описани начин формирати нови слој са називом 

Korišćenje_brojindeksa. За овај слој треба одабрати тип Polygon (Полигон). Одабрати 

координатни систем MGI 1901 / Balkans zone 7 (EPSG: 3909). У атрибутној табели 

додати два текстуална поља дужине 20 са називом „коришћење“ и „назив“. 

Дигитализација полигона се одвија на сличан начин као и дигитализација линија 

или тачака. Омогући се едитовање на слоју Korišćenje_brojindeksa притиском на 

. Додавање новог полигона почиње се притиском на . Код полигона се 

бирају граничне тачке линије. Завршетак дигитализације полигона се постиже 

притиском на десни тастер миша, након чега се отвара прозор за унос вредности 

атрибута.  

На слоју Korišćenje_brojindeksa ће се дигитализовати површине са различитим 

начином коришћења земљишта. Треба дигитализовати водене површине, урбана 

подручја и подручја под шумом. За водене површине и урбана подручја у 

атрибутну табелу уписати и називе. 

⮚ Снимити екран са дигитализованим површинама различитог начина 

коришћења земљишта. 
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17. Додавање растерског слоја 

 
Поред векторских података, у оквиру географских информационих система могу се 
користити и растерски подаци. QGIS подржава коришћење и растерских података, 
што се већ могло уочити у претходној вежби, пошто скенирана и 
геореференцирана топографска карта је дата у облику растерске слике.  
 
На почетку вежбе је потребно отворити нови пројекат и у Properties подесити 
координатни систем MGI 1901 / Balkans zone 7 (EPSG: 3909). Додавање растерског 

слоја се врши притиском на дугме   (Add Raster Layer) или избором менија Layer 
→ Add Layer → Add Raster Layer. Овим се отвара прозор где се притиском на дугме 

Browse  у дијалогу за додавање новог слоја пронађе локација растерске 
датотеке и потврди избор са Open. На претходно описани начин додати растерски 
слој који се налази у радном фолдеру D:\GIS vezbe\. Одабрати датотеку 
Vojvodina_padavine.tiff. На радној површини ће се приказати карта просечних 
годишњих сума падавина у Војводини.  
 
Растерски подаци су просторни подаци приказани матрицом где свака ћелија 
матрице (пиксел) носи одређену информацију о делу простора који представља. На 
примеру учитане растерске карте, сваки пиксел носи одређену бројчану вредност 
која представља просечну годишњу суму падавина на датој локацији. 

Коришћењем алата Identify  могу се проверити вредности пиксела као што је 
то приказано на слици. 
 

 
Слика 37. Вредности пиксела на карти просечних сума годишњих падавина  

      



Географски информациони системи - практикум 
П. Бенка, А. Бездан, Р. Земунац, Н. Сантрач 

49 
 

Од величине пиксела зависи колико ће фино или грубо подаци или објекти из 
природе бити приказани у растерском запису. Величина пиксела се може 
проверити дуплим кликом на активан слој (Vojvodina_padavine) у прозору Layers, 
где се у одељку Information налази вредност за величину пиксела изражену у 
метрима. У случају посматране карте, величина пиксела износи 1000 m. 
 

 
Слика 38. Очитавање величине пиксела за растерски слој 

 
Промена палете боја којом је растерски слој обојен се врши у прозору Layer 
Properties, до кога се долази дуплим кликом на активан слој (Vojvodina_padavine). У 
одељку Transparency може се задати провидност дела растерске карте без 
података, односно део растерске карте где су пикселима додељене вредности No 
Data. У поље Additional no data value треба унети број 0 и притиснути дугме Apply. 
 

 
Слика 39 Подешавање провидности за пикселе који не садрже податак 
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У одељку Symbology уместо палете сиве боје може се изабрати нека друга палета, 
која је можда визуелно прикладнија. У падајућем менију Render type изабрати 
SingleBand Pseudocolor, затим у одељку Color ramp изабрати одговарајућу палету, 
притиском на дугме Classify изврши се класификација, а затим се све потврди 
притиском на дугме ОК. 
 

 
Слика 40. Избор палете боја за приказ вредности пиксела 

⮚ Снимити екран са добијеним приказом падавина за територију Војводине. 
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18. Израда карте падавина (Print Layout) 

Део QGIS пакета који служи за подешавање садржаја картографских приказа се 

назива Print Layout. Print Layout се отвара као нови прозор и у њему се подешавају 

елементи картографског приказа. Предмет приказа ће бити садржај који је отворен 

у главном прозору QGIS-а.  

Нови Print Layout се отвара из падајућег менија Project → New Print Layout. За нови 

садржај картографског приказа треба одмах на почетку дефинисати назив. 

Распоред елемената (Layout) ће бити снимљен под овим називом унутар текућег 

пројекта и може касније поново да се отвори. С обзиром да ће се за израду карте 

користити подаци са годишњом сумом падавина, за назив Layout уписати Карта 

падавина. 

Након дефинисања назива, отвара се прозор Layout-a. У централном делу прозора 

се налази изглед композиције картографских елемената. Пошто још ништа није 

дефинисано, овај део је празан. Први корак у изради карте ће бити дефинисање 

димензија папира на којој ће бити одштампана карта. Потребно је поставити 

курсор миша на простор где ће бити креирана карта и притиском на десни тастер 

миша се добија мени. У меније треба одабрати Page Properties и дефинисати папир 

на димензије А4 (210x297 mm) и оријентација папира усправно (Portrait). 

 

Слика 41. Изглед прозора Print Layout-a 

Након тога може да се убаци карта која ће бити приказана. Одабере се дугме: 

 (Add new map). Притиском на леви тастер миша означити простор на коме ће 

бити исцртан садржај карте. У одељку Item properties за ставку Scale уписати 
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одговарајућу вредност имениоца размере. Узети неку округлу вредност, за формат 

папира А4 то може бити 1 500 000. Позиција и величина оквира карте се може и 

накнадно мењати. 

У доњем делу карте или на доњој маргини унети графички размерник притиском 

на дугме:  (Add new scalebar). Након позивања функције, мишем се означи 

позиција размерника. У случају графичког размерника може се подешавати изглед 

размерника, број сегмената, величина сегмента, боја итд. 

Изнад карте на средини уписати наслов КАРТА ПАДАВИНА притиском на дугме: 

 (Add new label). Након позивања функције се означи позиција текста, док се 

текст откуца у предвиђеном простору унутар одељка Item properties. Коришћењем 

истог алата испод карте са десне стране уписати текст Гаус Кригерова Пројекција, 

испод тога у другом реду текст Карту израдио Име и Презиме, број индекса. 

На погодном месту поставити легенду помоћу функције Add new legend, дугме:

. Као и код других елемената потребно је означити простор где ће бити 

постављена легенда. За назив уписати: Легенда (уместо енглеског Legend). 

Оставити отворен прозор Map Layout-a и у главном прозору QGIS-а променити 

назив слоја у Падавине у mm уместо Vojvodina_padavine. Вратити се у прозор Map 

Layout-a. Проверити изглед легенде. Уколико није дошло до промена, проверити 

да ли је означена опција Auto update и у главној палети притиснути дугме за 

освежавање Refresh . 

Убацити знак за север на погодно место притиском на дугме Add North Arrow  . 

Након избора простора где ће бити постављен знак за север, поставља се 

предефинисани знак за север. У Одељку Item properties у делу SVG browser може 

овај знак да се промени из галерије понуђених симбола.  Од понуђених одабрати 

одговарајући знак за север. Променом величине простора за овај знак се мења и 

његова величина. 
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Слика 42. Избор одговарајућег знака за север од понуђених знакова 

Подешавањем свих елемената карте подесити карту по свом нахођењу. 

Овако формирана карта може да се одштампа на штампачу  или да се 

генерише слика у .jpg или неком другом формату  или као .pdf документ 

притиском на дугме .  

⮚ Сачувати формирану карту у .jpg формату. 



Географски информациони системи - практикум 
П. Бенка, А. Бездан, Р. Земунац, Н. Сантрач 

54 
 

19. Рачунске операције са растерским подацима 

Са растерским подацима могуће је вршити бројне математичке и логичке 
операције ради добијања нових информација о анализираном проблему, бољем 
визуелном прегледу растерске карте и сл. Рачунске операције са растерским 
подацима се врше у прозору Raster Calculator (Raster → Raster Calculator). Прозор 
Raster Calculator се састоји из листе растерских слојева са којима се могу вршити 
рачунске операције, одељка са рачунским операцијама, поља за унос назива 
резултујућег растерског слоја, димензије растера, и поља за унос формуле. 
 

 
Слика 43. Прозор Raster calculator-а 

 
На пример, вредности пиксела за већ учитани растерски слој просечних годишњих 
падавина у Војводини (Vojvodina_padavine) могу се поделити са 2 и тако се може 
добити нови растерски слој.  
 
Да би се ово постигло, потребно је отворити прозор Raster Calculator-а. У горњем 
левом делу прозора двоструким кликом на лево дугме миша одабере се слој 
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Vojvodina_padavine, затим се двоструким кликом одабере операција дељење 
(дугме "/" од понуђених оператора и функција), иза оператора се унесе број 2. 
Потребно је још у пољу за резултирајући растер укуцати назив резултујућег растера 
(односно путања и назив). За овај пример одабрати назив Padavine_2. Све опције 
потврдити притиском на дугме ОК. 
 
Као потврда исправно унесене формуле, испод поља за унос формуле треба да се 
појави порука Expression valid. Након формирања новог слоја путем растер 
калкулатора, Алатом Identify могу се проверити нове вредности пиксела. 
 

 
Слика 44. Приказ просечних падавина и нови приказ са прерачунатим вредностима  

Рачунске операције се могу вршити и користећи вредности одговарајућих пиксела 
са два или више растерских слојева. На следећем примеру извршиће се сабирање 
вредности пиксела са слоја Vojvodina_padavine са вредностима са слоја Padavine_2. 
 
Да би се ово сабирање постигло, потребно је поново отворити прозор Raster 

Calculator-а. На претходно описани начин одабрати слој Vojvodina_padavine, 

одабрати рачунску операцију "+", и након тога одабрати слој Padavine_2. Уколико је 

формула за рачунање новог слоја добро унета, испод прозора са формулом 

приказује се порука: Expression valid. Даље је потребно унети и назив резултујућег 

слоја. За овај слој одабрати назив Padavine_3. Избор свих параметара потврдити 

притиском да дугме ОК. 

 
Слика 45. Нови растерски слој настао сабирањем вредности пиксела два растерска 

слоја 
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Одабрати алат Identify и проверити добијене вредности пиксела на новој карти. 

Користећи добијени слој Padavine_3, на претходно описани начин, извршити избор 

боја према вредности. Из добијеног приказа, путем Print Layout-a израдити нову 

карту. За назив карте исписати: ПРEРАЧУНАВАЊE РАСТEРСКИХ ПОДАТАКА.  

⮚ Формирати све потребне елементе карте и снимити карту у .jpg формату. 
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20. Дигитални модел терена 

Дигитални модел терена (Digital Terrain Model - DTM) је начин представљања 
површине терена у дигиталном облику и у основи је статистичка репрезентација 
непрекидне површине терена помоћу великог броја одабраних тачака са познатим 
X, Y и Z координатама у произвољном координатном систему. Површина терена се 
може представити коришћењем правилне мреже висина (grid – растерски формат) 
или коришћењем мреже неправилних троуглова (TIN – векторски формат). У 
наставку вежби, користиће се приказ дигиталног модела терена у растерском 
формату. 
 
За почетак вежбања је потребно отворити нови пројекат и дефинисати 
координатни систем MGI 1901 / Balkans zone 7 (EPSG: 3909). Датотека која ће 
представљати дигитални модел терена се учитава као и било који други слој са 

растерским подацима, притиском на дугме  (Add Raster Layer). У прозору за 
додавање растерског слоја изабрати датотеку fruska_gora.tiff, која се налази у 
радном фолдеру D:\GIS vezbe\.  
 
Дигитални модел терена Фрушке горе је добијен на основу дигиталног модела 
терена SRTM3 (Shuttle Radar Topografy Mission, https://www2.jpl.nasa.gov/srtm/) чија 
је просторна резолуција око 79 m. Вредности пиксела дигиталног модела терена 
представљају надморску висину терена на посматраној локацији. Алатом Identify 
може се утврдити да се за подручје Фрушке горе вредности пиксела, односно 
надморске висине крећу у опсегу од 71 до 540 m. На графичком приказу су 
вредности надморских висина иницијално дате у нијансама сиве боје: бела боја 
представља највише делове терена, за ниже делове терена, нијанса постаје 
тамнија. Делови без података (No data) су приказани црном бојом. 
 

Приказ избором боје према висини 

Ради јаснијег приказа висина терена, дигитални модел терена може се, уместо 
коришћења палете сиве боје, приказати коришћењем вишебојне палете. 
Коришћење вишебојне палете за приказ надморских висина терена се врши на 
потпуно исти начин, који је био приказан приликом приказа вредности падавина, у 
претходном делу вежбе рада са растерским подацима.  
 
У првом кораку се дефинише провидност растерског слоја за део подручја без 
података: отвори се Properties за слој fruska_gora, у одељку Transparency се у пољу 
Additional no data value упише се 0 и потврди се избор притиском на дугме Apply. 
 

https://www2.jpl.nasa.gov/srtm/
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Слика 46. Избор палете за приказ надморских висина терена 

У другом кораку се у одељку Symbology бира одговарајућа палета боја. Када се 
отвори одељак Symbology, треба у опцији Band Rendering за Render type одабрати 
Singleband pseudocolor, Под опцијама Color ramp треба одабрати одговарајућу 
палету. За ову вежбу се може ручно обавити класификација, одабрати за начин 
класификације Equal Interval, за број класа 11, за минималну вредност 50 а за 
максималну вредност 550. Подаци се класификују притиском на дугме Classify. На 
овај начин се добију интервали од 50 метара надморске висине, који одговарају 
висинама подручја Фрушке горе. Коначан избор се потврди притиском на дугме ОК 

 
Слика 47. Изглед дигиталног модела терена Фрушке горе коришћењем једне од 

понуђених палета боја 

У трећем кораку треба у Map Layout-u направити карту висина подручја Фрушке 

горе, коришћењем приказа добијеног избором одговарајуће палете. На карту 
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додати све потребне елементе карте (назив, размерник, легенду, правац севера ...) 

и израдити карту формата А4.  

⮚ Формирану карту снимити у .jpg формату.  

Рачунање нагиба терена (Slope) 

Рачунање нагиба терена коришћењем дигиталног модела терена у растерском 
формату врши се у коришћењем функције Slope, којa се по правилу инсталира са 
самим QGIS програмом. Функција Slope се може пронаћу унутар падајућег менија 
Raster (Raster → Analysis → Slope). Када се отвори прозор функције Slope, код ставке 
Input layer треба одабрати одговарајући ДТМ, у овом случају fruska_gora. У пољу 

Slope, кликом на  треба одабрати назив и локацију резултујућег слоја 
нагиба терена (Одабрати радни фолдер студента унутар фолдера D:\GIS vezbe и 
одабрати назив за нови растерски слој: nagibi_brojindeksa). У опцији Slope може се 
одабрати формат резултујућег фајла (одабрати GeoTiff с обзиром да је ДТМ у том 
формату). Није потребно мењати вредност корекционог фактора надморске висине 
(Ratio of vertical units to horizontal = 1.0). Вредности нагиба терена на посматраном 
подручју Фрушке горе се крећу у опсегу од 0,1° до 70°. Уколико се жели приказ 
новог слоја са нагибима у радном пројекту, означити опцију Open output file after 
running algorithm. Функција се извршава притиском на дугме Run. 
 

 
Слика 48. Подешавање параметара у прозору функције Slope 
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Слика 49. Приказ нагиба терена подручја Фрушке горе 

Коришћењем добијеног слоја направити карту нагиба Фрушке горе, са свим 

потребним картографским елементима.  

⮚ Карту сачувати у .jpg формату. 

Рачунање експозиција терена (Aspect) 

Путем експозиције се даје информација на коју страну света је нагнут одређен део 

терена представљен једним пикселом. Вредности експозиције терена се крећу у 

опсегу од 0° до 360°, што одговара вредности азимута у односу на правац севера (0° 

– север, 90° – исток, 180° – југ, 270° – запад). Израда слоја експозиција терена 

коришћењем дигиталног модела терена врши се помоћу функције Aspect. Може се 

пронаћу у падајућем менију унутар менија Raster (Raster → Analysis → Aspect). Исто 

као и случају нагиба терена, за Elevation layer треба одабрати одговарајући ДТМ 

(fruska_gora). У пољу Aspect треба одабрати назив и локацију резултујућег слоја 

експозиција терена (у радни фолдер студента снимити нови слој под називом: 

ekspozicija_brojindeksa). За опцију Output format одабрати GeoTiff. Функција се 

извршава притиском на дугме Run. 
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Слика 50. Прозор за подешавање параметара функције Aspect 

 
Слика 51. Приказ експозиција терена подручја Фрушке горе 

Одабрати одговарајућу палету боја и у Print Layout-у направити карту експозиција 

терена Фрушке горе, са свим потребним елементима.  

⮚ Карту сачувати у .jpg формату. 

Приказ осенчености терена (Hillshade) 

За пластичнији и визуелно лепши приказ рељефа терена може да се користи 

осенченост терена. Приказ осенчености дигиталног модела терена може да се 

добије коришћењем функције Hillshade (Raster → Analysis → Hillshade). Позивањем 

функције Hillshade се отвара прозор ове функције. Садржај овог прозора се 

разликује од претходна два (Slope и Aspect) у томе сто се овде јављају још и два 
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додатна параметра, односно хоризонтални и вертикални угао извора осветљења. 

Помоћу ових параметара се одређује смер падања сенке и дужина сенке.  

Као Elevation layer узети растерски слој са дигиталним моделом терена fruska_gora. 

Нови слој са сенчењем терена снимити у радни фолдер студента под називом 

osencenost_brojindeksa. Пре извршавања функције подесити углове осветљења по 

жељи. Функција се извршава притиском на дугме Run.  

 
Слика 52. Прозор за подешавање параметара функције Hillshade 

 
Слика 53. Приказ осенчености рељефа Фрушке горе 

Помоћу добијеног слоја израдити карту осенчености терена Фрушке горе, са свим 
потребним елементима.  

⮚ Карту сачувати у .jpg формату. 
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Генерисање изохипси из ДТМ-а  (Contour) 

Коришћењем дигиталног модела терена могу се генерисати изохипсе. Генерисање 
изохипси се врши у коришћењем функције Contour (Raster → Extraction → Contour). 
У прозору који се добије позивањем ове функције треба у пољу Input layer 
одабрати улазни ДТМ на основу којег ће се генерисати изохипсе. За ову вежбу 
користи се дигитални модел терена учитан као слој fruska_gora. У пољу Contours 
треба унети назив и локацију векторских датотека које ће бити генерисане у овом 
поступку. За ову вежбу треба нови векторски слој снимити у радни фолдер студента 
под називом izohipse_brojindeksa. У пољу Interval between contour lines треба унети 
еквидистанцију – висинску разлику између изохипси изражену у метрима. За ову 
вежбу уписати еквидистанцију 100 m. Да би се у атрибутној табели векторског слоја 
изохипси формирала колона у којој ће бити уписане вредности надморске висине 
за сваку изохипсу, потребно је означити Attribute name и у одговарајуће поље унети 
назив колоне (нпр.: visine). 
 

 
Слика 54. Прозор функције за генерисање изохипси из ДМТ 
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Слика 55. Изохипсе подручја Фрушке горе са еквидистанцијом 100 m 

 
У наставку вежбе ће се израдити карта са потпунијим начином приказа висинске 

представе терена Фрушке горе коришћењем комбинације изохипси, сенчења и 

хипсометријске скале (бојење према надморској висини). У панелу Layers оставити 

слојеве: fruska_gora, osencenost_brojindeksa и izohipse_brojindeksa. Поставити као 

горњи слој izohipse_brojindeksa, затим слој fruska_gora и као најнижи слој 

osencenost_brojindeksa. У особинама слоја izohipse_brojindeksa за боју линије 

изабрати неку тамну нијансу. За слој fruska_gora задржати класификацију и шему 

бојења како је у претходном делу вежбе дефинисано. У прозору Properties за овај 

слој, у одељку Transparency, вредност Global Opacity подесити на 50%. 

 

Слика 56. Подешавање провидности слоја fruska_gora. 

У прозору Layers променити назив овог слоја у: Nadmorske visine. Користећи 

добијени приказ у Print Layout-u израдити карту са овим приказом. За назив карте 

уписати: Приказ висинске представе Фрушке горе. Убацити све потребне елементе 

карте.  

⮚ Карту снимити у .jpg формату. 
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21. Повезивање података (Join) 

За поједине просторне ентитете (feature) на неком слоју се могу придруживати 

атрибутни подаци из других извора. За придруживање података потребно је 

успоставити везу између просторних ентитета по којој ће се преузимати подаци. 

Веза може да буде путем просторног положаја ентитета који преузима податке и 

од кога се преузимају подаци (Spatial Join) или да веза буде остварена према 

садржају неког поља атрибутне табеле и поља неке спољне придружене табеле 

(Join). 

Просторно повезивање – Spatial Join 

У овом делу вежбе ће се приказати преузимање података у атрибутну табелу 

користећи просторни положај елемената изворног и преклапајућег слоја. 

● Отворити нови пројекат у QGIS-у и поставити координатни систем (CRS) 

пројекта на MGI 1901 / Balkans zone 7 (EPSG: 3909).  

● Учитати векторске слојеве Met_stanice и Thiessen.  

Слој Met_stanice садржи позицију метеоролошких станица за територију Војводине 

као тачкастих објеката. Када се отвори атрибутна табела слоја Met_stanice, може се 

приметити да табела садржи једно текстуално поље у коме су дати називи 

метеоролошких станица. 

Слој Thiessen садржи генерисане Thiessen-ове полигоне, односно полигоне са 

утицајем појединих метеоролошких станица. Отварањем атрибутне табеле слоја 

Thiessen може се видети да она у ствари не садржи никакве податке. Табела 

садржи само једну колону где су све вредности 0. 

Примедба: Начин на који се могу израдити Тисенови полигони је објашњен у 

поглављу 24. 

Путем просторног повезивања треба преузети називе метеоролошких станица са 

слоја Met_stanice у слој Thiessen утврђујући која тачка слоја Met_stanice пада преко 

региона који покрива неки полигон слоја Thiessen. 

У менију Vector→Data Management Tools одабрати ставку Join Attributes by Location. 

За циљни слој (Base Layer) се одабере Thiessen, док се за преклапајући слој (Join 

Layer) одабере слој Met_stanice. С обзиром да је потребно да пронађемо слојеве 

који се преклапају, потребно је у Geometric predicate чекирати опцију intersect. 

Такође потребно је дефинисати локацију и назив датотека новог слоја, који ће 

настати придруживањем атрибута, у ставци Joined layer, избором дугмета  и 

опције Save to file отвара се нови прозор у којем је потребно изабрати локацију и 
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тип фајла. За локацију фајлова одабрати радни фолдер студента унутар фолдера 

D:\GIS vezbe\, а за назив слоја (датотека) изабрати Thiessen_brojindeksa. За ставку 

Join type одабрати опцију Create separate feature for each matching. Ова ставка је 

битна када се унутар полигона може наћи више објеката, па се може бирати 

између понуђених могућности: први пронађен, средња вредност, минимална 

вредност, максимална вредност итд. Поље поред ставке Discard records which could 

not be joined оставити празно. На овај начин ће се у излазном слоју наћи сви 

полигони циљног слоја, и они за које нису пронађени објекти у преклапајућем 

слоју. За ове полигоне ће поља у атрибутној табели остати непопуњена. 

Извршењем функције Join, формира се нови слој који се појављује на екрану.  

 

Слика 57. Прозор функције Join Attributes by Location 
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Слика 58. Проблем са Thiessen-ovim полигоном за метеоролошку станицу Београд 

Прегледом атрибутне табеле се може приметити да сада Тисенови полигони на 

новом слоју имају и поље које садржи назив метеоролошке станице. За један 

полигон (у једном реду у табели) је ово поље празно. Ово се догодило, пошто тачка 

која означава метеоролошку станицу Београд пада ван региона означеног 

Тисеновим полигоном (одсечен је до границе Војводине) (Слика 58). Ово поље 

треба попунити ручно, улазећи у мод едитовања атрибутне табеле слоја 

Thiessen_000. 

 

Слика 59. Ручно попуњавање атрибутне табеле за метеоролошку станицу Београд 

Након уписивања вредности Београд у одговарајућу ћелију табеле, снимити измене 

и завршити едитовање табеле притиском на исто дугме којим се омогућује 

едитовање. 
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Овим поступком је формиран нови слој који садржи Тисенове полигоне, где су у 

атрибутној табели придружени одговарајући атрибути са слоја са тачкастим 

објектима – метеоролошким  станицама. Уз постојеће атрибуте сваког полигона су 

додати атрибути тачке, која пада преко површине полигона. 

Повезивање преко атрибутне табеле – Attribute Join 

У наставку вежбе ће бити приказана могућност придруживања података из спољне 

табеле у атрибутну табелу постојећег слоја. 

Сваком полигону на претходно формираном слоју Thiessen_brojindeksa, који сада 

садржи називе метеоролошких станица, ће се придружити додатни метеоролошки 

подаци из спољне табеле. Спољна табела може бити формирана у неком програму 

који барата са табеларним подацима (Excel, Calc...) или базама података (MS 

Access...) али QGIS омогућује и учитавање података из обичне текстуалне датотеке 

уређене на одговарајући начин.  

У овом случају, подаци ће бити у обичној текстуалној датотеци са називом 

Tabela.txt. Ова датотека је тако формирана да су подаци у једном реду раздвојени 

коришћењем табулатора (За ближе објашњење видети поглавље 12. Израда слоја 

тачака из текстуалног фајла). Текстуалну датотеку учитати коришћењем функције 

 (Add Delimited Text Layer). У радном фолдеру пронаћи датотеку Tabela.txt.  
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Слика 60. Учитавање текстуалне датотеке као табеле у QGIS 

У одељку File format одабрати Custom delimiters и означити Tab (у доњем прозору 

се види какав ће бити резултат са појединим ставкама). Означити ставку No 

geometry (овим ће се подаци учитати само као табела, без слоја тачака – с обзиром 

да ови подаци не садрже податке о координатама тачака). 

Притиском на дугме Add ће се појавити и ова табела у списку слојева. Отварањем 

ставке Open Attribute Table може се проверити садржај ове табеле. Учитана табела 

садржи текстуално поље са називом метеоролошких станица (Stanica), и поља са 

надморским висинама (Kota), падавинама (P) и евапотранспирацијама (ETP)  за 

сваку станицу. 

У атрибутној табели претходно формираног слоја Thiessen_brojindeksa такође 

постоји поље Stanica, које садржи називе метеоролошких станица. Поље Stanica из 

атрибутне табеле и поље Stanica из спољне табеле (Tabela) ће бити искоришћени 

као кључ за повезивање. 

Напомена: Називи поља у обе табеле не морају да носе исти назив, битно је да 

садржај поља изабраног као кључ прве табеле одговара садржају поља које је 

изабрано као кључ у другој табели.  



Географски информациони системи - практикум 
П. Бенка, А. Бездан, Р. Земунац, Н. Сантрач 

70 
 

Повезивање слоја Thiessen_brojindeksa са спољном табелом Tabela се врши тако 

што се отвори ставка Properties за слој Thiessen_brojindeksa и отвори се ствака Joins. 

Веза са спољном табелом се додаје притиском на дугме "+". Овим се отвара нови 

прозор у којем се дефинише нова веза. 

 

Слика 61. Прозор Joins за слој Thiessen_brojindeksa . 

 

Слика 62. Дефинисање везе између атрибутне табеле слоја Thiessen_brojindeksa  и 
спољне табеле 

У прозору Add vector join за параметар Join layer треба одабрати назив спољне 

табеле, за ову вежбу то је претходно учитана табела са називом: Tabela, за 

параметар Join field се бира поље спољне табеле које ће служити као кључ за 



Географски информациони системи - практикум 
П. Бенка, А. Бездан, Р. Земунац, Н. Сантрач 

71 
 

повезивање – одабрати поље Stanica. Target field је поље у атрибутној табели слоја 

које одговара пољу Join field, у овом случају у атрибутној табели одабрати поље 

Stanica. Могуће је још дефинисати и која поља из спољне табеле желимо да 

придружимо (подразумевано је да ће сва поља бити придружена). Притиском на 

дугме Apply односно ОК се успоставља веза. 

Након успостављања везе, отворити атрибутну табелу слоја Thiessen_brojindeksa и 

проверити садржај табеле. Поља која су додата путем повезивања имају префикс 

Tabela_. 

⮚ Снимити екран са атрибутном табелом слоја Thiessen_brojindeksa . 
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22. Рачунање вредности новог поља у атрибутној табели 

Коришћењем добијених поља у атрибутној табели Thiessen_brojindeksa ће се 

срачунати водни биланс за подручја метеоролошких станица на територији 

Војводине. Водни биланс ће се добити када се од просечних падавина одузме 

вредност евапотранспирације. Вредност просечних падавина садржи поље 

Tabela_P док вредности евапотраспирација садржи поље Tabela_ETP. Водни биланс 

ће се добити: 

Vbilans = Tabela_P – Tabela_ETP 

За рачунање вредности новог поља у атрибутној табели слоја Thiessen_brojindeksa 

потребно је отворити атрибутну табелу тог слоја. Прозор за рачунање вредности 

новог (или неког већ постојећег) поља се покреће притиском на дугме Open field 

calculator  .  

 

Слика 63. Прозор Field calculator-a 

У отвореном прозору Field calculator-a означити ставку Create a new field. Потребно 

је дефинисати назив новог поља, новом пољу дати назив Vbilans. За тип поља 

изабрати децимални број (decimal number), и одабрати једно децимално место 
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(Precision). Потребно је још написати формулу по којој ће бити срачуната вредност 

овог поља. Користећи понуђене опције у Field and Values написати : "Tabela_P" - 

"Tabela_ETP". Притиском на дугме ОК се извршава ова формула за сваки ред у 

атрибутној табели.  

У атрибутној табели проверити добијени резултат. На овакав начин је могуће 

извршити и много компликованије прорачуне, користећи понуђене математичке 

операторе и функције. Поред попуњавања нових поља у атрибутној табели 

користећи вредности већ постојећих поља, вредности нових поља је могуће добити 

из геометријских особина објеката приказаних на слоју. Тако је могуће за тачкасте 

објекте у атрибутну табелу уписати координате тачке, за линијске објекте дужину 

линије или за полигоне површину, обим полигона итд. 

У наставку ове вежбе биће приказано рачунање површине и обима полигона 

приказаних на слоју Thiessen_brojindeksa. За рачунање површине полигона 

потребно је отворити прозор Field Calculator-a за овај слој.  

 

Слика 64. Уписивање површине полигона у атрибутну табелу 

За назив новог поља уписати: Povrsina, за тип података уписати Decimal number за 

Output field lenght уписати 20 и за precision 0. У прозору Function, у групи Geometry 

одабрати функцију $area и пребацити је у прозор Expression. Притиском на ОК, у 

атрибутној табели добија се ново поље са срачунатим површинама. Површине су 

дате у m2. Уколико се желе површине у хектарима, у поље Expression треба уписати 

$area / 10000. 
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У наставку вежбе самостално одредити обиме полигона на слоју 

Thiessen_brojindeksa у километрима, користећи функцију $perimeter. 

Снимити промене у атрибутној табели, искључити мод за едитовање (аутоматски се 

укључује када се извршава формула дефинисана у Field calculator-у).  

⮚ Направити снимак екрана са приказаном атрибутном табелом. 
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23. Израда тематске карте 

Подаци из базе података могу се визуелно приказати путем картографског приказа. 

Поред позиције тачке, линије или површине у одговарајућој размери, подаци из 

базе података могу на картографском приказу бити приказани путем симбола 

(његовог облика, боје, оријентације, величине) за тачкасте облике, бојом линије, 

обликом линије, величином линије, за линијске објекте односно путем боје, врстом 

испуне, величином симбола за испуну итд. за површинске елементе. 

Приказ места према броју становника 

Отворити нови пројекат и поставити координатни систем MGI 1901 / Balkans zone 7 

(EPSG:3909). За потребе ове вежбе потребо је учитати следеће слојеве: Mesta_tacke 

(места у Војводини, као тачкасти елементи), и Vojvodina granica (гранична линија 

Војводине). За слој Mesta_tacke, атрибутна табела садржи поље popis2011 где је 

уписан број становника тог места према попису из 2011. године.  

У properties слоја Mesta_tacke одабрати одељак Symbology. За начин приказа 

одабрати Graduated. Колона по којој ће бити класирање места је popis2011. 

Одабрати одговарајући симбол за приказ места. Градове класирати у 5 класа 

користећи Pretty Breaks начин класирања. Притиском на дугме Classify се изврши 

класирање. 

 

Слика 65. Дефинисање облика симбола и његове боје у зависности од броја 
становника 

Притиском на дугме ОК се приказују места у Војводини обојена одговарајућом 

бојом, према броју становника.  
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Приказ броја становника неког места се може визуелно ефектније приказати путем 

величине симбола. Ради оваквог начина приказа броја становника потребно је 

поново отворити  Properties за слој Mesta_tacke, отворити ставку Symbology и у 

опцији Method, за приказ уместо боје одабрати величину (Size). Овим се на карти 

приказују места путем истог симбола са пет различитих величина. Величина 

кружића се дефинише према полупречнику, по линеарној скали. Истраживања су 

показала да оваква скала величине симбола није погодна. Како би се још више 

побољшао визуелни приказ, потребно је поново отворити Properties → Symbology 

за слој Mesta_tacke. Вратити врсту приказа на Single Symbol. 

 

Слика 66. Напредно подешавање величине симбола 

Притиском на дугме десно од поља где се уписује величина симбола се отвара 

додатни мени у коме треба одабрати ставку Assistant. Овим се отвара нови прозор 

за подешавање величине симбола према садржају поља у атрибутној бази 

података. 
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Слика 67. Прозор за подешавање величине симбола према садржају поља у 
атрибутној табели 

У овом прозору за ставку Source одабрати поље popis2011, након тога кликнути 

дугме Refresh . Затим за Scale method одабрати Flannery. У овом прозору се још 

може подесити минимална и максимална величина симбола као и минимална и 

максимална вредност уписана у одабрано поље popis2011 (понуђене вредности су 

очитане из атрибутне табеле). Потврђивањем изабраних ставки се добије нови 

приказ. 



Географски информациони системи - практикум 
П. Бенка, А. Бездан, Р. Земунац, Н. Сантрач 

78 
 

 

Слика 68. Приказ броја становника места путем величине симбола. 

Користећи добијени приказ направити карту са називом: Места у Војводини према 

броју становника. На карту додати све потребне картографске елементе.  

⮚ Карту снимити у облику .jpg слике. 
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Приказ мреже путева према категорији пута 

Отворити нови пројекат и поставити координатни систем MGI 1901 / Balkans zone 7 

(EPSG: 3909). У овај пројекат додати слојеве Vojvodina putevi и Vojvodina granica. У 

Properties → Symbology слоја Vojvodina putevi одабрати ставку Categorized и за поље 

за класификацију (Column) одабрати поље KLASA. Притиском на дугме Classify 

извршити класификацију. За сваку добијену класу одабрати одговарајући симбол, 

дебљину линије и боју. У колони Legend уместо вредности А уписати Auto put, L – 

Lokalni put, M – Magistralni put и R – Regionalni put.  

Коришћењем овог приказа направити карту са насловом: Категорије путева у 

Војводини. Додати на карту све потребне картографске елементе.  

 

Слика 69. Класирање путева према врсти пута 

⮚ Сачувати добијену карту у .jpg формату. 
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Приказ густине становништва 

Отворити нови пројекат и поставити координатни систем MGI 1901 / Balkans zone  7 

(EPSG: 3909). У овај пројекат додати слој Vojvodina opstine. У прозору Properties у 

одељку Symbology овог слоја извршити класирање општина по густини 

насељености. Одабрати опцију Graduated. У атрибутној табели податак о густини 

становништва садржи поље GUST_NAS. Формирати 10 класа и одабрати 

одговарајућу палету боја. За начин класирања одабрати Pretty Breaks. 

 

Слика 70. Класирање општина према густини становника. 

Користећи добијени приказ у Print Layout-u формирати карту са називом: Густина 

становништа по општинама у Војводини. На карту додати све потребне 

картографске елементе.  

⮚ Сачувати карту у .jpg формату. 
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24. Панел са алатима (Processing Toolbox) 

Processing Toolbox је важан елемент корисничког интерфејса и служи за брзу 

обраду података, и један је од панела који се користи у свакодневном раду. У 

оквиру овог панела се приказује листа свих доступних алгоритама и алата 

груписаних у различите блокове. У суштини панел је приступна тачка за њихово 

покретање. 

За почетак је потребно додати панел са алатима на кориснички интерфејс. То се 

врши чекирањем опције View → Panel → Processing Toolbox. Након тога панел ће 

бити приказан на корисничком интерфејсу уз десну ивицу. 

 

Слика 71. Приказ Processing Toolbox-а на корисничком интерфејсу 

Претрага алгоритама и алата је веома брза и лака. Једноставним уносом имена у 

поље Search се приказују сви доступни алгоритми и алати под датим називом. Као 

пример за претрагу можемо да узмемо рачунање нагиба терена (Slope). Након 

уноса назива приказује се листа алгоритама са називом Slope. У оквиру овог 

практикума је предвиђен рад само са основним QGIS библиотекама. Стога се 

алгоритми из додатних библиотека (GDAL, GRASS, SAGA, ...) неће користити али су 

они кроз овај панел доступни. Двокликом на Slope унутар Raster terrain analysis 

блока, отвара се прозор за рачунање нагиба (Slope). 
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Слика 72. Претрага алгоритама и алата у Processing Toolbox-у 
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25. Употреба додатних библиотека (Plugin) 

Додатне библиотеке у QGIS-у додају корисне функције самом софтверу. Додатке су 

креирали QGIS програмери и други независни корисници који желе да прошире 

основну функционалност софтвера. Ови додаци су доступни у QGIS-у за све 

кориснике. 

Основни додаци су већ део стандардне QGIS инсталације. Да бисте их користили, 

потребно их је инсталирати (за то је потребна интернет конекција). Они се 

приказују кликом на Plugins → Manage and Install Plugins. Након тога се отвара 

прозор са свим основним додацима. Претрага се врши по имену кликом на Search. 

Као пример дат је поступак инсталације додатка под именом MapSwipe Tool који 

служи за једноставнији преглед више слојева. Када се унесе назив додатка у поље 

Search, и изабере одговарајући додатак потребно је кликнути на дугме Install Plugin. 

Након кратке инсталације поље поред назива додатка ће бити чекирано и додатак 

је инсталиран. Све додатке који су инсталирани овим путем можете пронаћи у 

падајућем менију Plugin. 

 

Слика 73. Претрага додатних библиотека у прозору Plugins 
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Слика 74. Преглед и одабир инсталираних додатних библиотека 
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26. Додавање новог слоја са удаљених извора у облику XYZ Tiles 

У QGIS постоји могућност да се неки подаци које се желе користити преузму са 

удаљених сервера у различитим форматима. За коришћење ове функционалности, 

неопходна је интернет конекција. Преузети подаци могу бити у растерском или 

векторском облику, у зависности од тога који су сервиси доступни на удаљеном 

серверу. Слој који се добија коришћењем XYZ Tiles јесте растерски слој. Садржај 

слоја је на серверу похрањен у виду малих правоугаоних растерских приказа 

(„плочица“). Ови растери се преузимају на основу координата дела простора који 

желимо приказати и на основу увећања (zoom-a). Растерске „плочице“ су 

геореференциране, тј. у приказу се поравнавају према координатама самог 

приказа. При померању приказа или промени увећања, са сервера се аутоматски 

преузимају нове плочице, и стиче се утисак „глатког“ прелаза. Приказ који се 

добије са XYZ Tiles сервера се може користити као позадина за друге слојеве које 

постоје у пројекту али и за дигитализацију нових елемената. 

За додавање новог слоја XYZ Tiles, потребно је прећи на панел Browser (уколико 

није у QGIS-у отворен овај панел, може се отворити путем менија View → Panels и ту 

означити опцију Browser. 

 

Слика 75. Укључивање Browser панела 
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У прозору Browser пронаћи ставку XYZ Tiles. Кликом левим тастером миша се могу 

отворити везе са серверима који су већ унети. Обично је иницијално унета веза са 

сервером Open Street Map. Двоструким кликом на леви тастер миша на одабрани 

садржај, у прозору са слојевима пројекта на коме се ради се појави нови слој са 

садржајем усклађеним са приказом подручја и увећањем (zoom).  

Притиском на десни тастер миша на ставку XYZ Tiles, отвара се нови мени, где се 

може направити нова веза са неким XYZ Tiles сервером.  

 

Слика 76. Креирање везе ка удаљеном XYZ Tiles серверу 

За додавање XYZ Tiles са приказом Google Satellite, за путању сервера додати: 

https://mt1.google.com/vt/lyrs=s&x={x}&y={y}&z={z} 

За додавање XYZ Tiles са приказом Google Satellite Hybrid, за путању сервера 

додати: https://mt1.google.com/vt/lyrs=y&x={x}&y={y}&z={z} 

За додавање Bing Virtual Earth сателитских снимака треба направити конекцију са 

сервером: http://ecn.t3.tiles.virtualearth.net/tiles/a{q}.jpeg?g=1 

Још неколико адреса за XYZ Tiles сервере:  

Google Map:  

https://mt1.google.com/vt/lyrs=r&x={x}&y={y}&z={z} 

https://mt1.google.com/vt/lyrs=s&x=%7bx%7d&y=%7by%7d&z=%7bz%7d
https://mt1.google.com/vt/lyrs=y&x=%7bx%7d&y=%7by%7d&z=%7bz%7d
http://ecn.t3.tiles.virtualearth.net/tiles/a%7bq%7d.jpeg?g=1
https://mt1.google.com/vt/lyrs=r&x=%7bx%7d&y=%7by%7d&z=%7bz%7d
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Esri Satellite:  

https://server.arcgisonline.com/ArcGIS/rest/services/World_Imagery/MapServer/tile/{z}

/{y}/{x} 

Esri World Topo: 

https://server.arcgisonline.com/ArcGIS/rest/services/World_Topo_Map/MapServer/tile/

{z}/{y}/{x} 

CartoDB: 

https://cartodb-basemaps-a.global.ssl.fastly.net/light_all/{z}/{x}/{y}.png 

Open Street Map: 

http://tile.openstreetmap.org/{z}/{x}/{y}.png 

Russian Topos: 

http://88.99.52.155/cgi-

bin/tapp/tilecache.py/1.0.0/topomapper_v2/%7Bz%7D/%7Bx%7D/%7By%7D.jpg 

Wikimedia: 

https://maps.wikimedia.org/osm-intl/{z}/{x}/{y}.png 

  

https://server.arcgisonline.com/ArcGIS/rest/services/World_Imagery/MapServer/tile/%7bz%7d/%7by%7d/%7bx%7d
https://server.arcgisonline.com/ArcGIS/rest/services/World_Imagery/MapServer/tile/%7bz%7d/%7by%7d/%7bx%7d
https://server.arcgisonline.com/ArcGIS/rest/services/World_Topo_Map/MapServer/tile/%7bz%7d/%7by%7d/%7bx%7d
https://server.arcgisonline.com/ArcGIS/rest/services/World_Topo_Map/MapServer/tile/%7bz%7d/%7by%7d/%7bx%7d
https://cartodb-basemaps-a.global.ssl.fastly.net/light_all/%7bz%7d/%7bx%7d/%7by%7d.png
http://tile.openstreetmap.org/%7bz%7d/%7bx%7d/%7by%7d.png
http://88.99.52.155/cgi-bin/tapp/tilecache.py/1.0.0/topomapper_v2/%7Bz%7D/%7Bx%7D/%7By%7D.jpg
http://88.99.52.155/cgi-bin/tapp/tilecache.py/1.0.0/topomapper_v2/%7Bz%7D/%7Bx%7D/%7By%7D.jpg
https://maps.wikimedia.org/osm-intl/%7bz%7d/%7bx%7d/%7by%7d.png
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27. Додавање новог слоја са Web Map Server-а 

Коришћење WMS (Web Map Server) је још једна могућност додавања слоја који 

садржи податке са удаљеног сервера. И у овом случају се добија растерски приказ, 

који се креира на страни сервера на основу векторских или растерских података. 

Приликом повезивања са WMS сервером, добија се одговор који слојеви се могу 

преузети. Избором неког од понуђених слојева, се подаци тог слоја приказују у 

оквиру текућег пројекта у QGIS-у. На основу радног простора који се приказује, 

серверу се шаље захтев. Сервер за приказани простор генерише приказ у облику 

геореференциране растерске слике, која се приказује у радном простору QGIS-а. 

Променом подручја приказа или променом увећања се од сервера добија нови 

приказ, који аутоматски мења стари приказ. У зависности од подешавања на WMS 

серверу, на преузетом слоју може бити активна могућност коришћења Identify 

Features, где се кликом на одређени објекат на приказу добијају информације о 

тачки, линији, полигону или пикселу, слично као када имамо локално похрањене 

податке таквог слоја. 

За додавање новог слоја са WMS, неопходно је прво дефинисати нову везу ка WMS 

серверу. У прозору Browser одабрати ставку WMS/WMTS и притиском на десни 

тастер отвара се мени где треба одабрати New Connection 

 

Слика 77. Отварање прозора за нову везу ка WMS серверу 

У прозору који се овим отвара се дефинишу параметри везе ка WMS серверу. За 

пример унети адресу: https://agris.rs/maps/zemljiste.map 

https://agris.rs/maps/zemljiste.map
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Слика 78. Креирање везе ка удаљеном WMS серверу 

Након повезивања, може се приметити да су на овом WMS серверу понуђена три 

слоја за приказ. Двоструким кликом на одабрани слој се додаје жељени слој у 

пројекат. Употребом алата Identify Features, могу се прочитати додатне 

информације за одабрани полигон.  

Са WMS сервера на адреси: https://maps.isric.org/mapserv?map=/map/bdod.map 

(SoilGrid) могу се преузимати прикази са различитим карактеристикама земљишта 

базирани на растерском приказу (величина пиксела је 250 m). 

 

https://maps.isric.org/mapserv?map=/map/bdod.map%20
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28. Интерполација 

ГИС програми обезбеђују алате за просторну анализу и израчунавање статистичких 

карактеристика и затим интерполацију података. Интерполација у ГИС окружењима 

проналази велику примену. Сваки корисник има различите захтеве за 

интерполацију у зависности од врсте посла који обавља. 

Просторна интерполација је процес коришћења тачака са познатим вредностима, 

за процену вредности у другим непознатим тачкама. На пример, да бисте 

направили мапу падавина за своју земљу, нећете пронаћи довољно равномерно 

распоређених метеоролошких станица да покријете цео регион. Просторна 

интерполација може проценити количину падавина на локацијама без 

забележених података коришћењем познатих очитавања количине падавина на 

оближњим метеоролошким станицама. Подаци о надморској висини, падавинама, 

акумулацији снега, подземним водама и густини насељености су други типови 

података који се могу израчунати коришћењем интерполације. Због високих 

трошкова и ограничених ресурса, прикупљање података се обично спроводи само 

на ограниченом броју одабраних локација. У ГИС-у, просторна интерполација ових 

тачака се може применити за креирање растера са проценама направљеним за све 

ћелије. 

Да би се генерисала континуална мапа, на пример, дигитална мапа надморске 

висине из тачака надморске висине мерених GNSS уређајем, мора се користити 

одговарајућа метода интерполације за оптималну процену вредности на оним 

локацијама где нису узети узорци или мерења. Резултати интерполационе анализе 

се затим могу користити за анализе које покривају целу област и за моделирање. 

На почетку вежбе је потребно учитати податке Vojvodina granica, Мet_stanice и 

Tabela.txt. Након учитавања, извршити повезивање између Мet_stanice и Tabela.txt 

преко атрибутне табеле (Attribute Join). Након тога су у атрибутној табели слоја 

met_stanice исписане вредности за просечну количину падавина за сваку станицу. С 

обзиром да се станице налазе на великим растојањима и да нам ти подаци нису 

довољни, потребно је извршити интерполацију између тачака. За те потребе ће 

бити коришћен атрибут (колона) P (просечне падавине).  

У зависности од врсте посла који обављамо можемо применити различите типове 

интерполације. У оквиру овог практикума ће бити приказане три често коришћене 

методе интерполације: Тисенови (Thiessen) полигони, Инверзно пондерисање 

удаљености (IDW) и мрежа неправилних троуглова (TIN). За све три интерполације 

ће се користити идентични полазни подаци. 
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Метода Тисенових (Thiessen-ових) полигона 

Код ове методе интерполације се подручје између тачака са познатим вредностима 

дели на полигоне. Унутар ових полигона је једна тачка са познатим вредностима, а 

за све тачке унутар једног полигона је то најближа тачка. У оквиру QGIS-а, алат који 

служи за интерполацију ових полигона се назива Voronoi polygons. Алат за ову 

интерполацију се може позвати у падајућем менију Vector → Geometry Tools → 

Voronoi polygons. 

 

Слика 79. Прозор за генерисање Тисенових полигона 

Као улазни слој се користи слој са тачкама. За ову вежбу за Input layer одабрати слој 

Мet_stanice. У пољу Buffer region се дефинише колико се подручје жели обухватити 

у односу на позицију тачака на улазном слоју. Уписати 30, како би формирани 

полигони покривали цело подручје Војводине. У следећем пoљу се наводи путања 

где ће бити снимљени добијени полигони. Притиском на дугме Run покреће се 

извршавање интерполације. Уз полигоне се формира и атрибутна табела, која 

садржи иста поља као и атрибутна табела тачака на улазном слоју. 

 

Метода инверзно пондерисање удаљености (IDW) 

У овој методи интерполације, тачке узорка се пондеришу током интерполације тако 

да утицај једне тачке у односу на другу опада са растојањем од непознате тачке 

коју желите да креирате. 

Пондерисање се додељује тачкама узорка коришћењем тежинског коефицијента 

који контролише како ће утицај пондера опасти како се растојање од нове тачке 
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повећава. Што је тежински коефицијент већи, мање ће ефекти имати тачке ако су 

далеко од непознате тачке током процеса интерполације. Како се коефицијент 

повећава, вредност непознате тачке се приближава вредности најближе тачке 

посматрања. 

IDW интерполација се налази у Processing Toolbox-у. У поље Search је потребно 

укуцати IDW interpolation. Унутар блока Interpolation двокликом на IDW 

interpolation се отвара нови прозор.  

 

Слика 80. Претрага IDW алгоритма за интерполацију у Processing Toolbox-у 

У њему је потребно дефинисати Met_stanice као Vector Layer. Затим је потребно у 

пољу Interpolation attribute изабрати колону из атрибутне табеле која означава 

просечну количину падавина (Tabela_P). Кликом на дугме плус  додајемо унете 

податке у поступак интерполације.  

 

Слика 81. Избор атрибута по којем ће бити вршена интерполација 

С обзиром да се станице налазе у Војводини и да је потребно креирати мапу 

падавина за Војводину, у поље Extend jе потребно уврстити величину подручја које 

се жели обухватити. То се врши кликом на падајући мени  Set to current map 
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canvas extent → Calculate from Layer → Vojvodina granica. На овај начин је 

дефинисано подручје за које се врши интерполација. Након тога је потребно 

дефинисати и величину растера који се креира (Output raster size). У поља Pixel size 

X и Pixel size Y унети вредност 100. 

 

Слика 82. Дефинисање величине растера 

У поље Interpolated одабрати радни фолдер студента унутар фолдера D:\GIS vezbe\ 

а за назив слоја (датотека) изабрати IDWinterpolacija_padavine_brojindeksa. 

 

Слика 83. Подешавање параметара за IDW интерполацију 
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Слика 84. Падавине у Војводини креиране на основу IDW интерполације 

  

Метода мреже неправилних троуглова (TIN) 

Метода TIN интерполације је још један популаран алат у ГИС-у. Уобичајени TIN 

алгоритам се зове Деланејева триангулација. У овој триангулацији се покушава да 

се створи површина коју чине троуглови најближих суседних тачака. Да би се то 

урадило, креирају се кружнице око одабраних тачака узорка и њихови пресеци су 

повезани у мрежу троуглова који се не преклапају и који су што је могуће 

компактнији. 

Главни недостатак TIN интерполације је то што површи нису глатке и могу дати 

назубљени изглед. Ово је узроковано дисконтинуираним нагибима на ивицама 

троугла и тачкама података узорка. Поред тога, триангулација генерално није 

погодна за екстраполацију изван области са прикупљеним тачкама података узорка 

за разлику од IDW методе. 

TIN интерполација се налази у Processing Toolbox-у. У поље Search је потребно 

укуцати TIN interpolation. Унутар блока Interpolation двокликом на TIN interpolation 

се отвара нови прозор.  
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Слика 85. Претрага TIN алгоритма за интерполацију у Processing Toolbox-у 

У њему је потребно дефинисати met_stanice kao Input Layer → Vector Layer. Затим је 

потребно у пољу Input Layer → Interpolation attribute изабрати колону из атрибутне 

табеле која означава просечну количину падавина (Tabela_P). Кликом на дугме 

плус  додајемо унете податке у поступак интерполације.  

С обзиром да се станице налазе у Војводини и да је потребно креирати мапу 

падавина за Војводину, у поље Extend је потребно уврстити величину подручја које 

се жели обухватити. То се врши кликом на падајући мени  Set to current map 

canvas extent → Calculate from Layer → Vojvodina granica. На овај начин се 

дефинише подручје за које се врши интерполација. Након тога је потребно 

дефинисати и величину растера који се креира (Output raster size). У поља Pixel size 

X и Pixel size Y унети вредност 100. 

У поље Interpolated одабрати радни фолдер студента унутар фолдера D:\GIS vezbe\ 

а за назив слоја (датотека) изабрати TINinterpolacija_padavine_brojindeksa. 
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Слика 86. Подешавање параметара за TIN интерполацију 

 

 

Слика 87. Приказ падавина у Војводини креиране на основу TIN интерполације 



Географски информациони системи - практикум 
П. Бенка, А. Бездан, Р. Земунац, Н. Сантрач 

97 
 

29. Одсецање растера (Clip raster) 

Након креирања IDWinterpolacija_padavine_brojindeksa по задатим границама 

Војводине, добијен је правоугаони растер који обухвата Војводину и њен шири 

појас. Како би се сувишан део одсекао примениће се алат за одсецање растера (Clip 

raster). Овај алат служи за одсецање растера на основу подручја дефинисаног у 

векторском формату типа полигон. Први корак је креирање векторског слоја типа 

полигон од векторског слоја Vojvodina granica који је типа линија. То се врши 

помоћу алата Vector → Geometry tools → Lines to polygons који врши 

трансформацију линија у полигоне. За Input layer изабрати Vojvodina granica, док је 

у поље Polygons потребно одабрати радни фолдер студента унутар фолдера D:\GIS 

vezbe\ а за назив слоја (датотека) изабрати VojvodinaGranica_polygon_brojindeksa. 

 

Слика 88. Трансформација линија у полигоне 

 

Слика 89. Приказ слоја VojvodinaGranica_polygon 
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Након креирања слоја VojvodinaGranica_polygon_brojindeksa, имамо све неопходне 

податке за одсецање слоја IDWinterpolacija_padavine_brojindeksa по границама 

Војводине. У падајућем менију Raster → Extraction → Clip raster by mask layer се 

налази алат за одсецање растера. Кликом на њега отвара се прозор у који је 

потребно за Input layer изабрати слој IDWinterpolacija_padavine_xx, за Mask Layer 

изабрати слој VojvodinaGranica_polygon_brojindeksa, за Source CRS и за Target CRS 

изабрати MGI 1901 / Balkans zone 7 (EPSG: 3909). 

У поље Clipped (mask) одабрати радни фолдер студента унутар фолдера D:\GIS 

vezbe\ а за назив слоја (датотека) изабрати IDWinterpolacija_Vojvodina_brojindeksa. 

 

Слика 90. Дефинисање параметара за одсецање растера 
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Слика 91. Одсечени растер 
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30. Одсецање вектора (Clip) 

Приликом интерполације путем Тисенових полигона, добијени полигони не прате 

границу Војводине. Слично, као што је могуће одсећи растерске податке, и 

векторски подаци могу се одсећи тако да на слоју остану елементи који су 

обухваћени полигоном који представља границу. За извођење ове вежбе потребно 

је учитати слојеве Voronoi_brojindeksa и претходно формиран полигон за подручје 

Војводине VojvodinaGranica_polygon_brojindeksa. Алат за одсецање векторских 

података се може пронаћи путем падајућег менија Vector → Geoprocessing Tools → 

Clip. За Input layer одабрати слој Voronoi_brojindeksa а за Overlay layer одабрати 

VojvodinaGranica_polygon_brojindeksa. У поље Clipped одабрати радни фолдер 

студента унутар фолдера D:\GIS vezbe\ а за назив слоја (датотека) изабрати 

Voronoi_Vojvodina_brojindeksa. 

 

Слика 92. Дефинисање параметара за одсецање вектора 
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Слика 93. Тисенови полигони одсечени за територију Војводине 
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31. Формирање тампон зона (Buffer) 

У оквиру геопросторних истраживања и истраживања појава у животној средини, 

често се јавља потреба за одређивањем тампон зона или зона утицаја (енг. Buffer 

zone). Тампон зона представља подручје које разграничава објекте у стварном 

свету, односно представља зону утицаја неких њихових карактеристика. Неки од 

типова тампон зона могу бити: ветрозаштитни појасеви, зелени појасеви унутар 

урбаних подручја, граничне зоне између држава, зоне заштите од буке, зоне 

заштите од загађења дуж река и друге. 

 

 

Слика 94. Бафер зоне око векторских објеката 

У контексту ГИС анализа, тампон или бафер се односи на област око векторског 

објекта, која је формирана мерењем удаљености или радијуса од/око датог 

објекта. Независно од типа векторског објекта који се анализира (тачка, линија или 

полигон), као продукт генерисања бафер зоне, увек се добија полигон (Слика 94). 

Функција формирања бафера у QGIS-у налази се унутар падајућег менија Vector → 

Geoprocessing Tools → Buffer. Одабиром ове функције отвара се нови прозор, у 

коме се врши селекција векторског слоја за који се формира бафер и 

спецификација параметара слоја који ће бити генерисан (Слика 95). 

За вежбу користити слој Saobracajnice, који је формиран приликом вежбе 

дигитализације полилинија са геореференциране карте. 
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Слика 95. Прозор за подешавање опција функције Buffer 

Ставком Input layer врши се одабир векторског слоја за који ће се формирати 

бафер. Ширина бафер зоне подешава се у одељку Distance. У овом кораку постоји 

могућност одабира јединице мере у којој ће бити наведена ширина бафер зоне. 

Понуђене јединице мере зависе од референтног координатног системa (CRS) који је 

одабран за улазне векторске податке. Како се предложени слој за вежбу налази у 

пројекцији – правоуглом координатном систему (MGI 1901 / Balkans zone 7) 

понуђене су дужинске мере (m, km, feet, miles, yards). У случају да је одабран неки 

од географских координатних система, ширина бафер зоне би била изражена у 

степенима. Ставком Segments дефинише се број линијских сегмената који 

апроксимирају четвртину круга приликом креирања заобљених деоница. 

Параметар Miter limit је примењив само у случају одабира стила Miter у оквиру 

ставке Join style. Под ставком Buffered дефинише се име и локација 

новоформираниг полигона који ће представљати бафер зону. Дугметом Run 

покреће се формирање новог слоја према задатим параметрима. 

За вежбу одабрати ширину зоне од 50 m, за Segments одабрати од 5 до 10, за End 

cap Style и Join Style одабрати Round и слој сачувати под називом 

Saobracajnice_baferi. Могућности формирања бафера испробати и са векторским 

слојевима типа тачка и полигон. 
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32. Разграничење сливног подручја 

Сливно подручје (слив) је основна јединица свих хидролошких истраживања. 

Према дефиницији, слив неког водотока представља површину са које све воде 

дотичу до тог реципијента. Граница сливног подручја назива се вододелница. 

Топографска (површинска) вододелница добија се спајањем тачака са највишом 

надморском висином између суседних сливова. У инжењерској пракси и генерално 

области управљања водама, често се јавља потреба за дефинисањем 

(разграничењем) сливног подручја неког водотока. Често су границе сливова 

великих река познате и релативно лако доступне за проналажење у векторском 

формату. Међутим, приликом анализа неких мањих природних водотока, 

планинских река или потока, јавља се потреба да аналитичар/истраживач 

самостално генерише границу сливног подручја. Овај тип анализе могуће је 

извршити у ГИС окружењу, коришћењем дигиталног модела терена (DTM) и 

неколико специфичних алата доступних у оквиру QGIS-а. 

За извођење ове вежбе користиће се дигитални модел терена Фрушке горе 

(fruska_gora.tif), са жељом да се изврши разграничење слива Роковог потока. Овај 

водоток протиче низ северну падину Фрушке горе и улива се у Дунав (Слика 96). 

 

Слика 96. Траса Роковог потока 
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За почетак вежбања је потребно отворити нови пројекат и дефинисати 

координатни систем (ETRS89 / UTM zone 34N (EPSG: 25834)). Додати растерски слој 

дигиталног модела терена Фрушке горе (fruska_gora.tif). 

Напомена: Уколико је дигитални модел терена дат у географским координатама 

(latitude/longitude) као што је WGS 84, неопходно је да се изврши репројекција у 

неку од пројекција са правоуглим координатама (нпр. УТМ). Ово је важно због 

накнадног коректног рачунања неких карактеристика слива (нпр. површина, 

дужина вододелнице). Ова конверзија (репројектовање) се врши из падајућег 

менија Raster → Projections → Warp (Reproject). Овом путањом, отвара се нови 

прозор у коме се дефинише слој (растер) за који ће се вршити репројектовање, 

затим изворни CRS и жељени CRS. У овом кораку постоји могућност подешавања 

резолуције репројектованог растера. У овом случају задржаће се почетна 

резолуција ћелије улазног растера од 79 m (SRTM3). Репројектовани слој може да 

се генерише као привремени фајл или да се сачува под жељеним именом на диску 

рачунара (дефинише се у одељку Reprojected). Функција се покреће притиском на 

дугме Run. 

У конкретном примеру, приложени ДМТ (fruska_gora.tif) је већ репројектован у 

УТМ пројекцију, те се претходно описани корак може изоставити. 

 

Слика 97. Конверзија (репројектовање) координатног система дигиталног модела 
терена 
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У наредном кораку користи се алат Fill Sinks (Wang & Liu), који користи алгоритам за 

идентификацију и „пуњење“ површинских депресија на дигиталном моделу 

терена, уз очување подужних падова дуж токова (јаркова). Ово се постиже 

задржавањем минималних нагиба (израчунатих на основу висинских разлика 

између ћелија растера). Путања ка овом алату је следећа: падајући мени Processing 

→ Processing toolbox → SAGA → Terrain analysis - Preprocessing → Fill Sinks (Wang & 

Liu), (Слика 98). У случају настанка проблема приликом обраде великих и детаљних 

скупова података (нпр. података снимљених LiDAR-ом) упућује се на коришћење 

алатa Fill Sinks XXL (Wang & Liu). Учитати репројектовани ДМТ Фрушке горе. За 

потребе анализе биће потребно израдити само Filled DEM, a за Minimum Slope 

користити вредност 0,01%. Извршење функције се покреће притиском на дугме 

Run. Овим кораком се заправо врши корекција аномалија ДМТ и сликовито 

представља рељеф терена. Слика 99 приказује производ ове функције, који је 

накнадно стилизован. 

 

Слика 98. Подешавање параметара функције Fill Sinks (Wang & Liu) 
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Слика 99. Растер добијен извршењем функције Fill Sinks (Wang & Liu) 

У следећем кораку, потребно је извршити препознавање речне мреже. У ту сврху 

користи се алат Strahler Order (Processing → Processing toolbox → SAGA → Terrain 

analysis - Channels → Strahler Order). Као улазни слој у овом кораку користиће се 

кориговани ДМТ добијен у претходном кораку (Filled DEM). На овај начин добијају 

се пиксели који представљају најниже делове терена, којима се вода дренира ка 

реципијенту (Слика 100). 

 

Слика 100. Генерисање речне мреже алатом Strahler Order и идентификација 
водотока 

Након генерисања речне мреже, потребно је идентификовати водоток од интереса. 

Ово је могуће урадити коришћењем подлога попут Google Satelite, OpenStreetMap и 

сличних. Овде се мануелно може препознати тражени водоток, на основу 

преклапања траса водотока на посматраној подлози и генерисаном растеру. 

Напомена: У случају потребе, генерисање подсливова и мреже водотока у 

векторском формату, могуће је извршити алатом Channel Network and Drainage 

Basins, који се налази унутар SAGA пакета са алатима: SAGA → Terrain analysis - 

Channels → Channel Network and Drainage Basins. Као улазни растер (Elevation) 

користи се кориговани ДМТ (Filled DEM), затим се одреди ред водотока (Threshold) 
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за које ће бити извршено генерисање подсливова и мреже водотока. За показну 

вежбу за Threshold вредност ставити 4. На овај начин добијена је мрежа са 

припадајућим подсливовима (Слика 101). 

 

Слика 101. Генерисање подсливова и мреже водотока у векторском формату 

За последњи корак делинеације слива користи се алатка Upslope Area, којa се 

такође налази унутар SAGA пакета са алатима: SAGA → Terrain analysis - Hydrology → 

Upslope Area (Слика 102). За извршење ове функције неопходно је за Elevation 

поставити кориговани ДМТ. Такође потребно је дефинисати координате 

контролног/излазног профила водотока, односно тачке до које се врши 

разграничење слива. У ту сврху неопходно је направити нови векторски слој (типа 

Point) и ручно уцртати тачку на профилу водотока, како би се могле очитати њене 

координате. За параметар Method у овом случају користити Multiple Flow Direction. 

Извршење функције се покреће притиском на дугме Run. 

Напомена: Прецизно очитавање координата тачака излазног профила могуће је 

извршити на два начина. Један од њих је преко атрибутне табеле, коришћењем 

Field calculator-a. У оквиру Field calculator-a, направити нове колоне X i Y. 

Коришћењем функција Geometry → $x и $y добиће се прецизне координате 

уцртане једне или више тачака. Други начин је коришћењем Plugin-a Coordinate 

Capture . Позиционирањем курсора на жељену тачку, могуће је очитати тачне 

координате, које ће бити унете приликом подешавања параметара функције 

Upslope Area. 



Географски информациони системи - практикум 
П. Бенка, А. Бездан, Р. Земунац, Н. Сантрач 

109 
 

 

Слика 102. Подешавање параметара за функцију разграничења слива 

Извршењем функције Upslope Area добија се растер чије вредности пиксела могу 

бити 0 и 1. Површина чији пиксели носе вредност 1 представљају површину слива 

(Слика 103). 

 

Слика 103. Разграничен слив Роковог потока 

За даљи рад, предлаже се уређивање добијеног растерског слоја. Како би се 

уклонило подручје које није од интереса (на Слици 104 представљено црном 
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бојом), коришћењем Raster Calculator-a прерачунати нови растер са задавањем 

Raster Calculator Expresion: Upslope Area > 0. Овиме се издваја само подручје слива 

од интереса. Уколико постоји потреба за рачунањем површине слива или дужине 

вододелнице, неопходно је извршити „полигонизацију“ добијеног растера. Из 

падајућег менија Raster, одабрати ставку Conversion → Polygonize (Raster to Vector). 

Као улазни слој користити претходно генерисани растер, затим одабрати име и 

информацију која ће се пренети у новоформирани вектор и сачувати под жељеним 

називом, на пример Sliv Rokovog potoka. На основу претходно стечених знања 

везаних за рачунање површина и обима, израчунати површину генерисаног слива и 

дужину вододелнице. Такође, према жељи стилизовати и представити разграничен 

слив са ширим подручјем Фрушке горе. Слика 105 представља пример графичке 

репрезентације. 

 

Слика 105. Слив Роковог потока, са његовом главном притоком и излазним 
профилом 

 

 

 

 

 

 

 

 

 
 Роков поток 

 

Излазни 
профил 
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